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1. INTRODUCTION 
Back to Table of Contents 

The GEN4 PRO XTREME system can be configured to operate on almost any engine 
configuration, normally aspirated; nitrous oxide injected, supercharged and turbocharged 
applications. BigStuff3 has partnered with EFI Analytics to refine the BigComm Pro software to 
work specifically with the GEN4 PRO XTREME systems. The BigComm Pro software is designed to 
measure, calibrate and record the engine parameters and acts as the graphical user interface 
between the GEN4 PRO XTREME ECU and the engine it is installed on. The BigComm Pro 
software allows the user extraordinary fuel, ignition and power management system tunability 
for improved performance and drivability. 

The BigComm Pro software allows full user access to all of the Curves, Tables & Parameters 
needed to calibrate the GEN4 PRO XTREME system. Calibrations can be modified both “on-line” 
and “off-line”. The engine control Curves, Tables & Parameters are stored in the GEN4 PRO 
XTREME ECU non-volatile memory, allowing for the stored information not to be lost when 
power to the ECU is removed.  

2. BIGCOMM PRO SOFTWARE DOWNLOAD OVERVIEW 
Back to Table of Contents 

The BigComm Pro (BCP) software can be downloaded directly from the www.BigCommPro.com 
website. It will require an internet connection to be established with the PC that the BCP 
software will be downloaded onto. It is assumed the PC is not connected to the GEN4 PRO 
XTREME ECU during the BigComm Pro software download. 

The BCP software download package includes an example Project containing a demo calibration 
and preconfigured Dashboards and Tuning Tabs to help get you acquainted with the PCB 
software offline. This will be described in further detail in these instructions. 

The minimum PC requirements to run the BigComm Pro GEN4 software are: 

• Microsoft Windows XP, Vista, 7, 8, 10, OSX 10.6+, & Linux 
• 1.6 GHz Intel Core i5 minimum.  
• 8GB of RAM minimum. Ideally, 16+ GB RAM 
• RJ45 Ethernet port recommended. A USB port can also be used with a USB-to-RJ45 

Ethernet adapter (not included). 

The following steps detail how to download the BigComm Pro software onto a PC. 

http://www.bigcommpro.com/
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Step 2.1 - With the PC connected to the internet, type bigcommpro into the web browser and hit 
enter. At this point, the PC should not be connected to the GEN4 PRO XTREME ECU. 

 

 

Step 2.2 - Select BigComm Pro. 
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Step 2.3 - Once the www.BigCommPro.com home page opens, select DOWNLOAD NOW. 

 

Step 2.4 - Download the BigComm Pro Beta for Gen 4 by selecting Download. 

 

http://www.bigcommpro.com/
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Step 2.5 - Once the BigCommGen4 executable has completed downloading (84 MB), select it 
from the lower left-hand corner of the screen. 

 
Step 2.6 - Select Run. 
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Step 2.7 - Select Yes. 

 
 

Step 2.8 - Select Next > 
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Step 2.9 - Select “I accept the agreement” and then select Next > 

 
 

Step 2.10 - Select Next > 
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Step 2.11 - Select Next > 

 
 

Step 2.12 - Check the “Create a desktop icon” box and then select Next > 
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Step 2.13 - Select Install. 

 
 

Step 2.14 - After selecting Install from Step 2.13, a status bar will appear showing the progress 
of the BigComm Pro (BCP) GEN4 software download to your PC. 
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Step 2.15 - Select Finish. 

 
 

Step 2.16 - After selecting Finish from Step 2.15, after a slight pause, the GEN4 PRO XTREME 
graphic screen will appear momentarily. 
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Step 2.17 - After another slight pause, the following GEN4 PRO XTREME software window will 
open. At this point, the software is running on your PC and you can work offline with an example 
Local Project: BigStuff3_Gen4_ExampleProject by selecting Work offline. The example Local 
Project contains a demo calibration, preconfigure dashboards and tuning tabs and should only 
be used offline. 

 
Step 2.18 - After selecting Work offline from Step 2.17, the following Main Dashboard window 
will open. Now would be a great time to navigate the GEN4 PRO XTREME BigComm Pro software 
to get acquainted with it before establishing an “online” connection. 

3. REQUIREMENTS TO ESTABLISH ONLINE COMMUNICATION BETWEEN 
PC RUNNING BIGCOMM PRO SOFTWARE AND GEN4 PRO XTREME ECU 
Back to Table of Contents 
“Online” communication refers to the actual live connection between the PC running the 
BigComm Pro software and GEN4 PRO XTREME ECU. The following things need to occur in order 
to establish online communication.  

• The GEN4 PRO XTREME Main Wire Harness’ (MWH) (2) Cinch 30-way ENGINE (A-K) & 
ENGINE (L-Y) connectors must be connected to the GEN4 PRO XTREME’s (2) Cinch 30-way 
ENGINE (A-K) & ENGINE (L-Y) connectors. This connection must take place after the 
GEN4 PRO XTREME MWH’s BATTERY (+) & Battery (-) leads are connected directly to the 
vehicle’s battery.  
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• The GEN4 PRO XTREME Main Wire MWH’s pink, 12V Switch wire must be connected to 
the vehicle’s switched ignition source and be powered on. 

• A “Wired” or “Wireless” Ethernet connection needs to be established between the PC 
running the BigComm Pro software and GEN4 ECU an online communication. This is 
thoroughly detailed in the GEN4 PRO XTREME System Hardware_BigCommPro Install 
Manual located on the BS3 website under the GEN4 PRO XTREME tab. Pages 14 and 15 
provide high-level configuration overviews for the Wired Ethernet network options. Pages 
16 and 17 provide high-level configuration overviews for the Wireless Ethernet network 
options. The Wired Ethernet network connection options are straight forward and do not 
require a WiFi connection. However, the Wireless Ethernet network connection options 
require a WiFi interface to establish online communication between the PC running the 
BigComm Pro software and GEN4 PRO XTREME ECU. Details on how to establish an online 
WiFi connection start on page 18.  

• The GEN4 PRO XTREME ECU’s integrated RJ45 connector’s Orange LED begins to flash. 
 
 

 

 

 

 

 
 
 
 
 
 
 

THIS AREA LEFT BLANK INTENTIONALLY 
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Wired Ethernet Network 1 configuration for “In-Vehicle” applications
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Wired Ethernet Network 2 configuration for “Race-Car” & Dyno applications  
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Wireless Ethernet Network 1 configuration for “In-Vehicle” applications 
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Wireless Ethernet Network 2 configuration for “Race Car” & Dyno applications 
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4. ESTABLISH WIFI WIRELESS ETHERNET NETWORK CONNECTION 
BETWEEN PC RUNNING THE BIGCOMM PRO SOFTWARE AND GEN4 PRO 
XTREME ECU  
Back to Table of Contents 
The following steps detail how to establish a WiFi Wireless Ethernet Network Connection 
between a PC running the BigComm Pro GEN4 software installed and a GEN4 PRO XTREME 
Wireless Ethernet Network using the yellow GLiNet Wireless Router for In-Vehicle applications or 
the NETGEAR N600 Wireless Router for Race Car applications. It assumes the In-Vehicle or Race 
Car Wireless Router Network connections detailed on page 16 or 90 have been established. 

Note: The GEN4 PRO XTREME system includes an ID card that identifies the GEN4 Wireless 
Network Name (GLiNet or NETGEAR) and Security Key (Password) as shown below. The ID card is 
located in the sleeve attached to the GLiNET Mini Smart Router box or NETGEAR N600 Router 
box. The GEN4 Wireless Network Name (GLiNet or NETGEAR) and Security Key (Password) are 
required to establish the initial wireless connection between the BigComm Pro software running 
on a PC and GEN4 PRO XTREME ECU. Be sure not to misplace the GEN4 wireless Network Name 
and Security Key (Password) ID card and do not share it with others.  
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Step 4.1 – Once the PC is powered on, left-mouse click on the up arrow in the lower right-hand 
corner of the tool bar as shown below.  

Step 4.2 – Left mouse click on the Wireless Network icon as shown below. 
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Step 4.3 - Once the Wireless Network window opens, 
highlight and left mouse click on the GEN4 Wireless 
Network name as shown below. For this example, the 
GEN4 Wireless Network Name is; GEN4 WIFI GLiNET 
0020, per the above GEN4 Wireless Network Name 
(GLiNet or NETGEAR) and Security Key (Password) ID card. 

Always be sure to highlight and left mouse click on the 
GEN4 Wireless Network Name (GLiNet or NETGEAR) that 
appears on the ID card included with your GEN4 PRO 
XTREME system. 

Note: The GEN4 Wireless Network uses two naming 
conventions dependent on which wireless router is being 
used. If the yellow GLiNet “In-Vehicle” wireless router is 
being used, the GEN4 Wireless Network naming 
convention is “GEN4 WIFI GLiNET 0001 thru 9999”. If the 
NETGEAR N600 “Race Car” wireless router is being used, 
the GEN4 Wireless Network naming convention is “GEN4 
WIFI NETGEAR 0001 thru 9999”. 

 

 

 

Step 4.4 - Once the GEN4 WIFI GLiNET Wireless Network 
dialogue window opens as shown below, check the 
Connect automatically box and then left mouse click on 
Connect. 
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Step 4.5 - Once Connect is selected from Step 4.4, the 
following dialogue window will open. It has a blank 
dialogue box under the Enter the network security key 
text. This is where the network security key needs to be 
entered. 

Key Point!!! The Network Security Key is also referred 
to as the GEN4 Wireless Network Security Key 
(Password). 

For this example, the GEN4 Wireless Network Security Key 
(Password) is; RZ94JA5R, per the above GEN4 Wireless 
Network Name (GLiNet) and Security Key (Password) ID 
card. 

Note: Be sure to use the GEN4 Wireless Network 
Security Key (Password) as it appears on the GEN4 
Wireless Network Name (GLiNet or Netgear) and Security 
Key (Password) ID card included with your GEN4 PRO 
XTREME system. All GEN4 Wireless Network Security Keys 
(Passwords) use numbers and/or uppercase letters. 

 

Step 4.6 - Type the GEN4 Wireless Network Security 
Key (Password) under the Enter the network security 
key dialogue box as shown below and highlight and left 
mouse click on Next. 
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Note: The provided GEN4 Wireless Network Security Key (Password) is not required to be 
entered again after the initial wireless connection between a specific PC & GEN4 Wireless 
Network has been established. The only time the provided Wireless Network Password is 
required to be entered again is to establish a new wireless connection between a different PC 
running the BigComm Pro software and GEN4 PRO XTREME ECU.  

Note: You can change the GEN4 Wireless Network Name and/or Password. You may want 
to change the GEN4 Wireless Network Name to easily associate it to a specific vehicle if 
running multiple vehicles with multiple GEN4 PRO XTREME Wireless Networks. 
Instructions on how to change the GEN4 Wireless Network Name and/or Password are 
located on the BS3 website under the GEN4 PRO XTREME section. 

 

Step 4.7 - After left mouse clicking on Next from Step 4.6, 
the following dialogue window will open asking; “Do you 
want to allow your PC to be discoverable by other PCs 
and devices on this network?”, Highlight and left mouse 
click on No. 
 

 

 

 

 

 

 

 

 

  

 

Step 4.8 - Once No is selected from Step 4.7, the 
following window will open showing your specific GEN4 
WIFI GLiNET (0001 thru 9999) network is Checking 
network requirements and is attempting to establish a 
wireless connection with the PC.  
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Step 4.9 - After a brief period of time, the following window will open to indicate the wireless 
network connection has been established between the PC and your specific GEN4 WIFI GLiNET 
(0001 thru 9999) or GEN4 WIFI NETGEAR (0001 thru 9999) wireless router. 

Reminder: The GEN4 Wireless Network name will be GEN4 WIFI GLiNET (0001 thru 9999) if using 
the yellow GLiNET “In-Vehicle” wireless router. The GEN4 Wireless Network name will be GEN4 
WIFI NETGEAR (0001 thru 9999) if using the NETGEAR N600 “Race Car” wireless router. 

 

 

 

 

 

 

 

 

 

 

 

  
 
Once the Wireless Network Connection has been established as detailed in Steps 4.1 thru 4.9, an 
initial online communication can be established between the PC running the BCP software and 
GEN4 PRO XTREME ECU connected to the GEN4 WIFI GLiNET (0001 thru 9999) or GEN4 WIFI 
NETGEAR (0001 thru 9999) wireless router. 
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5. ESTABLISH ONLINE COMMUNICATION BETWEEN PC RUNNING 
BIGCOMM PRO SOFTWARE AND GEN4 PRO XTREME ECU 
Back to Table of Contents 
The following steps describe how to establish online wired or wireless communication between 
the PC running BigComm Pro Software and GEN4 PRO XTREME ECU. The initial online connection 
also “Activates” the BigComm Pro software and GEN4 PRO XTREME ECU interface to enable the 
BCP software to create an initial Project. (This only occurs when connecting between a PC 
running the BCP software and GEN4 PRO XTREME ECU for the first time) 

Step 5.1 - Once the GEN4 PRO XTREME ECU is powered on (VBATT (+), VBATT (-) & +12V switched 
Ignition), and a Wired or Wireless Ethernet Network connection is established between the PC 
running the BigComm Pro software and GEN4 PRO XTREME ECU, open the GEN4 PRO XTREME 
BCP software from the PC’s desktop by double clicking on the GEN4 PRO XTREME BCP icon 
located in the lower left-hand corner of screen. 
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Step 5.2 - Once the BCP icon is selected, the following GEN4 PRO XTREME graphic will 
momentarily appear on the screen. 

 

Step 5.3 - After a momentary pause, the following BCP software window will open. As you can 
see, there are two possible selections to choose from; 

The first is: Bigstuff Gen4, Serial# 70-B3-D5-64-E0-15. This is the Serial Number (MAC ID) of the 
GEN4 PRO XTREME ECU that will be communicating with the PC running the BCP software once 
it’s activated.  

The second is: Bigstuff Gen4, Serial# 22-33-44-55-66-77. This is the default serial number 
associated with the example Local Project: BigStuff3_GEN4_ExampleProject running offline on 
the PC. The example Local Project: BigStuff3_GEN4_ExampleProject was included as part of the 
BCP software download package and contains a demo calibration, preconfigure dashboards and 
tuning tabs and is only meant to be used offline to navigate and get aquantitied with the BCP 
software. 
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Before an initial Project can be created, the BigComm Pro software & GEN4 PRO XTREME ECU 
interface needs to be activated. This is initiated by single clicking on Activate Device. 
 

There are a couple of key things that occur when Activate Device is selected; 

● The BCP software & GEN4 PRO XTREME ECU interface is activated by entering the end 
user-name and contact information. 

● The BCP software creates an initial Project using the Serial Number (MAC ID) of the GEN4 
PRO XTREME ECU connected to the PC running the BCP software and activation 
information. The initial Project contains preconfigured Gauge Clusters; aka “Dashboards”, 
Tuning & Dyno Views; aka “Tuning Tabs” and “Datalog Tabs” with predefined 
measurement variables. 
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Step 5.4 - Once Activate Device is selected in Step 5.3, the following BCP dialogue window will 
open.  

 

 

 

 

 

 

 

 

 

 

 
 
Step 5.5 - Fill in the requested activation information and single click on Activate.  
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Step 5.6 – Once Activate is selected in Step 5.5, the following BCP software window will open. As 
you can see, there is now only one selection to choose from; 

The Bigstuff Gen4, Serial# 70-B3-D5-64-E0-15 is the Serial Number (MAC ID) of the GEN4 PRO 
XTREME ECU connected to the PC running the BCP software.  Please note the Device Activation 
information (i.e. the owner’s name, Jim Jackson for this example) filled out in Step 3.5 is now 
associated with the initial Bigstuff Gen4, Serial# 70-B3-D5-64-E0-15 Project that will be 
uploaded into the BCP software running on the PC. 

The previous default Bigstuff Gen4, Serial# 22-33-44-55-66-77 serial number that had the 
example Local Project: BigStuff3_GEN4_ExampleProject associated with it has been removed. It 
was only intended to provide an example Project BigStuff3_GEN4_ExampleProject as part of the 
BCP software download package to navigate and get acquainted with the BCP software before 
establishing online communication. 
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Step 5.7 - To establish online communication between the BCP software running on the PC and 
GEN4 PRO XTREME ECU single click on Connect. 

Step 5.8 – Below, is the BCP default Main Dashboard window that opens after selecting 
Connect in Step 5.7.  
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For this example, Jim Jackson Serial 70-B3-D5-64-E0-15 is the Project running in the BCP 
software on the PC. For your application, Your Name Serial 70-B3-D5-64-XX-XX will be the 
Project running in the BCP software on the PC. 

There are several key things that occur when Connect is selected; 

● Online communication is established between the BCP software running on the PC and 
GEN4 PRO XTREME ECU. 

● The calibration file included with the GEN4 PRO XTREME ECU is uploaded into the BCP 
software running on the PC. 

The next necessary step is to save the calibration file, also known as “Tune”, included with the 
GEN4 PRO XTREME ECU, into the initial Project. This is covered in Steps 5.9 thru 5.13 below.  

The following steps describe how to save the calibration file, also known as “Tune”, included with 
the GEN4 PRO XTREME ECU into the initial Project. (This only occurs when connecting between a 
PC running the BCP software and GEN4 PRO XTREME ECU for the first time) 

Step 5.9 - It is necessary to save the calibration file, also known as “Tune”, included with the 
GEN4 PRO XTREME ECU into the initial Project. This is straight forward and initiated by 
highlighting and left mouse clicking on File in the upper left hand-hand corner of the BCP 
software tool bar as shown below.  
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Step 5.10 - Once File is selected in Step 5.9, a drop-down window will open. Once opened, 
highlight and left mouse click on Save Tune As as shown below. 

 
 
 
 
 
 

 

 

 

THIS AREA LEFT BLANK INTENTIONALLY 
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Step 5.11 - Once Save Tune As is selected in Step 5.10, a Save Tune Configuration dialogue 
window will open as shown below. Once opened, you will see a BCP File Name automatically 
assigned to the calibration file as shown below. The automatically assigned calibration file name 
for this example is 2018-12-30_15.08.13.bigTune, which is the date and time the calibration file is 
saved.  

 

 

 

 

 

 

THIS AREA LEFT BLANK INTENTIONALLY 
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Step 5.12 - You can overwrite the automatically assigned calibration File Name with a naming 
convention of your choice by highlighting and typing a file name over the automatically assigned 
BCP software File Name. For this example, the calibration File Name is Your Calibration File 
Name. 

Once the new calibration File Name is typed in, left mouse click on Save. Once Save is selected 
the BCP software will automatically add the .bigTune suffix to the file name while saving the 
calibration file into the Project file associated with the GEN4 PRO XTREME ECU currently 
connected to the PC running the BCP software. For this example, the calibration file will be saved 
into the Jim Jackson Serial 70-B3-D5-64-E0-15 Project File. 

 

 

 

THIS AREA LEFT BLANK INTENTIONALLY 
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Step 5.13 – Once Save is selected in Step 5.12, the following BCP window will open showing the 
Jim Jackson Serial 70-B3-D5-64-E0-15 Tune Saved! message in the lower left-hand corner of the 
BCP window as shown below.  

That’s it… You’re now communicating online via a Wired or Wireless Ethernet connection 
between the PC running the BigComm Pro software and GEN4 PRO XTREME ECU with the initial 
Project loaded and calibration saved into the GEN4 PRO XTREME ECU. 

Key Note: You must go through a +12V switched ignition key cycle (key on/off/on) in order to 
establish online communication with a different GEN4 PRO XTREME ECU! 

 

 

The balance of the instructions will focus on how to “use” the BigComm Pro software as a 
graphical user interface to calibrate, measure and record all accessible parameters available to 
the GEN4 PRO XTREME system. 

This manual has been put together so you can learn and apply the changes as quick as possible 
to your ECU. 

Please don’t forget to check out our FAQ section for the most common questions asked about 
the software answered in one area. 
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6. NAVIGATING THE BIGCOMM PRO SOFTWARE FOR THE FIRST TIME  
Back to Table of Contents 
Once you have downloaded the BigComm Pro software onto a PC as detailed in the previous 
steps, you can now begin to navigate it offline (PC only) or online (live communication between 
PC running BigComm Pro software and GEN4 PRO XTREME ECU). Dependent on whether your 
offline or online will dictate, which of the initial BigComm Pro window opens when launching the 
BigComm Pro software.  

Below, are the initial BigComm Pro screen screenshots that will open after 
double clicking on the BigComm GEN4 shortcut Icon found on your PC’s 
desktop and shown to the right. 

Initial “Offline” BigComm Pro launch window – “Work offline” 

 

  

 

 

 

 

 

 

Initial “Online” BigComm Pro launch window – “Connect” 
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From a user standpoint, the BigComm Pro software will operate the same whether you’re offline 
or online.  

Before we get into the software and how the nuts bolts are all turned let’s get you familiar with 
how BigComm Pro is used. BigComm Pro GEN4 software is a comprehensive software suite that 
will contain all of your tuneups, datalogs, project backups, and individual saved tables. These 
files will be stored in the Documents folder on your computer  

 

C:\Users\YourComputer\Documents\BigCommGen4Projects. See the following picture for 
more detail.  

 

1 

2 

3 
4 

5 

6 
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1. The CurrentTune is the most recent tuneup that BigComm Pro has automatically saved as your 
working on your Project. The icon indicates a BigCommPro tuneup you can open.  
 

2. A .bigTunepart file is an individual backup of a table or chart from your tuneup. You can 
create as many as you like per table. This will be described in more detail in the bigTunepart 
how to in Section 3 of this manual. 

 
3. The projectCfg file is where the project system files are located.  

 
4. The restorePoints folder is where BigCommPro creates automatic project backups as you 

are working on your project. This feature is similar to Windows Restore in that it creates 
backups as you are working in case you want to go back to an earlier date/time in your 
project. See restorePoints how to in Section 3 of this manual. 
 

5. The DataLogs folder is where all datalogs will be stored whether they are started manually 
on your computer or when you upload the replays out of the MicroSD card.  
 

6. The dashboard folder is where all of your dashboards will be stored. Your custom created 
dashboards will be stored there as well.   

Now that you know how the file structure works and where your files will be stored let’s get 
started on how to work inside a BigComm Pro Project.   
 
 
 
 
 
 
 
 
                                                   
 
                                                THIS AREA LEFT BLANK INTENTIONALLY 
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7. WORKING WITH THE INITIAL OFFLINE BIGCOMM PRO LAUNCH 
WINDOW 
Back to Table of Contents 

The following instructions detail how to work with the initial offline BigComm Pro launch window 
as shown below. An overview will be provided for each of the highlighted items.  
 

 
 
 
 
 
 

 

  

 
 
 
 
 
 
 
 
 
 

 
The following instructions detail how to work with the initial offline BigComm Pro launch window 
as it relates to the Offline File, Options, Data Logging, Tools & Help Tool Bar. 
 

Offline File, Options, Data Logging, Tools & Help Tool Bar: 

There are 5 pulldown menu options included in the Offline File, Options, Data Logging, Tools 
& Help Tool Bar. Each pulldown menu serves a specific purpose. The first is File.  Left click on 
File and the following submenu will open.  

 
 
 
 
 
 

 

Offline File, Options, Data 
Logging, Tools & Help Tool Bar 

Offline Gauge Cluster  & 
Devices Tool Bar 

Work Offline 
selection button 

Illuminated scroll bar to indicate the 
BigComm Pro software is waiting for the 

Work offline button to be selected 

GEN4 PRO XTREME ECU Serial 
Number, Name of person who 
holds BigComm Pro software 
registration & Local Project 

file name 

Search  
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Note: An online Project has more options available under the File dropdown. This will be 
covered later in the instructions under Section 8. Working with an online BigComm 
Pro Project. 

File: Under the File dropdown submenu you can open an existing Project, import a Project 
backup, load an existing tune or exit the program.  

 
• Select Open Project to open an existing Project. Do so by selecting File  Open Project 

in the pulldown menu or press ALT+O and select the Project you want to open on your 
computer. Press Select to finish and open.   

 
 

• Select Import Project Backup to import a Project Backup file.   
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• Select Load Tune (bigTune) to load a saved tune from a Project. Do so by selecting File  
Load Tune (bigTune) in the pulldown menu or press CLT+O and then select and open the 
.bigtune calibration file you want to open on your computer.  

 
• Select Exit to exit out of BigComm Pro. 

There are 5 pulldown menu options included in the Offline File, Options, Data Logging, 
Tools & Help Tool Bar.  Each pulldown menu serves a specific purpose. The second is Options.  
Left click on Options and the following submenu will open. 

 
 
 
 
 
 
 
 

 
Options: Under the Options dropdown submenu you can choose your default Language, the 
Look and Feel of the software, software Preferences, Project Restore Points, and Data Logging 
Preferences.  
 

• Select Language to choose your default language. Do so by selecting Options  
Language in the pulldown then select the desired language from the options in the 
pulldown menu. You will need to restart the BigComm Pro software for the changes to 
take effect.    
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• Select Look and Feel to set up the BigComm Pro software look and feel. Do so by 

selecting Options  Look and Feel in the pulldown and then select from one of the 
desired software layout the options in the pulldown menu. You will need to restart 
the BigComm Pro software for the changes to take effect.    
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• Select Preferences to set up the BigComm Pro software preferences. Do so by selecting 
Options  Preferences in the pulldown and then select the desired software 
preferences from the options in the pulldown menu.  These will allow you to configure 
how you want to interact with the BigComm Pro software. The default settings will satisfy 
the most users requirements.   

 

  

  

 
• Select Restore Points to set up the BigComm Pro software restore points. Do so by 

selecting Options  Restore Points in the pulldown and then select the desired software 
Restore Points from the options in the pulldown menu.  The default settings will satisfy 
the most users requirements.   
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• Select Data Logging Preferences to set up the BigComm Pro software Data Logging 
Preferences. Do so by selecting Options  Data Logging Preferences in the pulldown 
and then select the desired Data Log Format and Data Log Naming from the options in 
the pulldown menus.   
 
For the Data Log Format you can choose between ASCII Format (.CSV) or Enhanced 
Format (.MLG).  Select .CSV if you want to plug the data log information into a 
spreadsheet. .MLG is the default and recommended file extension for BigComm Pro.   

  
For the Data Log Naming you can choose how to label the data logs on the start or stop of 
the data log or have the software silently auto name the log files. The default settings will 
satisfy the requirements of most users.   
 

 
 
 
 
 
 
 

There are 5 pulldown menu options included in the Offline File, Options, Data Logging, 
Tools & Help Tool Bar. Each pulldown menu serves a specific purpose. The third is Data 
Logging. Left click on Data Logging and the following submenu will open. 
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Data Logging: Under the Data Logging dropdown submenu you can choose if you want to view 
the Data Log file with the MegaLog Viewer.  
 

• Select View with MegaLog Viewer to set up the BigComm Pro software to view the data 
log data in MegaLogViewer. You will need to download the MegaLogViewer software from 
the www.BigCommPro.com website. Once the MegaLogViewer software is downloaded 
onto your PC, select Data Logging  View with MegaLogViewer or by pressing Alt-V in 

the pulldown and then select the desired log file when the window opens.     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There are 5 pulldown menu options included in the Offline File, Options, Data Logging, 
Tools & Help Tool Bar. Each pulldown menu serves a specific purpose. The fourth is Tools. Left 
click on Tools and the following submenu will open. 

 
 
 
 
 
 
 
 
 

 

http://www.bigcommpro.com/
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Tools: Under the Tools dropdown submenu you can choose to update and install a new GEN4 
PRO XTREME firmware. This is described further under the online Project section of the 
instructions. 
 

• Select Tools to update and install a new GEN4 PRO XTREME firmware. Do so by selecting 
Tools  Update / Install Firmware in the dropdown. Tools only has the ability 
to update/install firmware when a Project is not open. 

There are 5 pulldown menu options included in the Offline File, Options, Data Logging, 
Tools & Help Tool Bar. Each pulldown menu serves a specific purpose. The fifth is Help. Left 
click on Help and the following submenu will open. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Help: Under the Help dropdown submenu you can choose from a number of Help related 
options as detailed below.  
 

• Select Help to choose from a number of Help related options. Do so by selecting Help to 
show the Help dropdown submenu options.  

 
• The Help menu is where BigCommPro lets you:  

o BigComm Gen4 Help - Provides access to additional online/offline help 
information. The BigComm Gen4 Help provides additional details for many of the 
BigComm Pro software capabilities and should be considered as a key source for 
helpful information. 
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o Check for Update - Allows BigCommPro to check for a software update if your 

connected to the internet. 
o Automatic Update Check - Automatically checks for a BigComm Pro software 

update every time BigCommPro boots up and there is an internet connection.  
o Update Registration - Allows you to Update your Registration after purchasing a 

software key to enable all of the BigComm Pro features. 
o Remove Registration Information – Allows you to remove your registration 

from the current computer running the BigCommPro software.  
o Submit BigCom Gen4 Review - Allows you to submit a review 

of BigCommPro software. 
o Create BigCom Gen4 Debug Package – Allows you to create 

a BigCommPro debug package.  
o About – Provide details for the current version of your BigComm Pro software.   

The following instructions detail how to work with the initial offline BigComm Pro launch window 
as it relates to the Offline Gauge Cluster & Devices Tool Bar. 
 
Offline Gauge Cluster & Devices Tool Bar: 

When initially working with an offline BigComm Pro project the Gauge Cluster and Devices tabs 
are only available.  

• The Devices tab lists the current Projects on your computer screen.   
• The Gauge Cluster tab provides the ability to open a project and shortcuts to  
      helpful links about the software. 
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Search:   

There is no Search functionality relative to the initial offline BigComm Pro launch window. The 
Search functionality works once the offline or online BigComm Pro main default launch window 
is opened. Further details will be provided in Section 8 - Working with an online BigComm 
Pro Project. 

Work offline selection button:  

The Work offline selection button is selected to open an offline Project.  

8. WORKING WITH AN ONLINE BIGCOMM PRO PROJECT 
Back to Table of Contents 

The following instructions detail how to work with an online BigComm Pro Project and utilize all 
of the BigComm Pro functionality relative to the BigComm Pro main default launch window.  
 
Note: Most of the online BigComm Pro software functionality also pertains to offline BigComm 
Pro software functionality. Therefore, for the sake of redundancy, these instructions will only 
cover the online BigComm Pro software functionality. 
 
At this point it is assumed, the GEN4 PRO XTREME ECU is powered on (VBATT (+), VBATT (-) & 
+12V switched Ignition), and a Wired or Wireless Ethernet Network connection is established 
between the PC running the BigComm Pro software and GEN4 PRO XTREME ECU. 
After double mouse clicking on the Connect, the BigComm Pro’s main online default launch 
window will open as shown below on page 53. 
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BigComm Pro main online default launch window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following instructions detail how to navigate and utilize all of the BigComm Pro 
functionalities relative to the main online default launch window. The following instructions 
pertain to all online use cases and most of the offline use cases. An overview will be provided for 
each of the items highlighted below.   
 
 
 

 
 
  

Application 
Indicator Dash 

Online File, Options, Data 
Logging, Tools & Help Tool Bar 

 

Online Gauge Cluster, Tuning & 
Dyno Views, Graphing & 

Logging, High Speed Loggers, 
Auto-Tune & Devices Tool Bar 

Main online default 
launch window Dash 

Search 

 

The Data Logging display will light up when a data 
logger is active. The RunTime Data display should 
be around 100 when communicating online. The 
Records Logged display will show the actual 
records logged on the PC.  
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9. BIGCOMM PRO ONLINE FILE, OPTIONS, DATA LOGGING, TOOLS & 
HELP TOOL BAR 
Back to Table of Contents 

There are 5 pulldown menu options included in the Online File, Options, Data Logging, Tools & 
Help Tool Bar. Each pulldown menu serves a specific purpose. The first pulldown menu is File. 
Left click on File and the following submenu will open.  

 
 

 
  
 

 

 

 

 

 

 

File: Under the File dropdown you can; open a Project, Load Tune Restore Points, Load Tunes, 
Save Tunes, Compare Tunes, modify your Gauge Clusters, choose to Work Offline and Exit from 
the BigComm Pro software.   

• Select Vehicle Project to open an existing Project. Do so by selecting File  Vehicle Projects 
in the pulldown submenus and select the Project you want to open on your computer. Press 
Select to finish and open.   
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• The Vehicle Project dropdown submenu enables you to:  

o Open Project or press Alt-O - Will open an Open Project window to allow a new or 
current project to opened and selected.  

o Close Project or press Alt-X - Will close the current BigComm Pro Project. 
o Create Backup Project - Allows a Project Backup to be created. This will be covered in 

detail in the Special Features section. Click HERE for more information.   
o Import Project Backup - Allows you to import a Project backup file. This will be covered 

in detail in the Special Features section. Click HERE for more information.   
o Show Project Folder – Opens the current Project folder. 
o Project Properties or press Ctrl-P – Will open a Project Properties window to be viewed. 

  
There are 5 pulldown menu options included in the Online File, Options, Data Logging, Tools & 
Help Tool Bar. Each pulldown menu serves a specific purpose. The second pulldown menu is 
Options.  Left click on Options and the following submenu will open. 

 
 
 
 
 
 
 
 

 
Options:  Under the Options dropdown submenu you can; choose your default Language, the 
Look and Feel of the software, software Preferences, Project Restore Points, and Data Logging 
Preferences.  The Options menu is the same whether a Project is open, closed or offline/online 
with an ECU.  Therefore, the Options overview on pages 45 thru 48 is the same and will not be 
repeated here.  
  
There are 5 pulldown menu options included in the Online File, Options, Data Logging, Tools & 
Help Tool Bar. Each pulldown menu serves a specific purpose. The third pulldown menu is Data 
Logging.  Left click on Data Logging and the following submenu will open. 
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Data Logging: Under the Data Logging dropdown submenu you can; Start Logging, take a look 
at Logging Profiles, configure how Trigger Logging, View the data log data with MegaLogViewer, 
Show the Datalog Folder. The Data Logging pulldown menu has additional features which are 
the same whether a project is open or closed or offline/online with an ECU. However only certain 
features can be enabled.    
 
• The Data Logging dropdown submenu enables you to:  

o Start Logging or press Ctrl-L to start a new datalog to your PC. Even if the vehicle is not 
running you can start a datalog to record your sensors or anything else you want to log.   

o Logging Profiles - INFO COMING SOON  
o Triggered Logging - Allows the Automatic Logging Trigger to be enabled, Start and Stop 

logging criteria to be configured and the data log length of time to be set.   
o View with MegaLogViewer - MegaLogViewer software or press Alt-V to start.  
o Show Datalog Folder - Will open the Datalog Folder on your PC.  
o Performance and Economy Fields - INFO COMING SOON  

 
How to Start, Stop and Save a Datalog to your PC: 

• Select Start Logging to start a new a datalog to your PC. Do so by selecting Data Logging  
Start Logging in the pulldown menu or by pressing Ctl-L. Once open, highlight and mouse 
click on Start Logging to start the datalog. 
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• Once the datalog is started, the Data Logging monitor, located in the top right-hand corner 
of the screen, will turn green to indicate the datalog has started and the Records Logged 
monitor will show the datalog records being logged as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• To stop the datalog, select Data Logging  Stop in the pulldown menu or by pressing Ctl-K. 

Once the pulldown menu opens, highlight and mouse click on Stop to stop the datalog. 
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• Once Stop is selected, the Data Logging monitor will turn off to indicate the datalog has 
stopped, the Records Logged monitor will stop recording the datalog records and a Rename 
Data Log File window will appear to allow the datalog file to be saved as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• At this point, you can save the datalog file using the default File Name or rename it by typing 

in your own datalog file name in place of the default File Name. Once renamed, highlight and 
click on Save to save the datalog file to the PC as shown below. 
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How to configure the Datalog Trigger criteria:  

• Select Triggered Logging to configure the datalog trigger criteria. Do so by selecting Data 
Logging  Triggered Logging in the pulldown menu. Once open, highlight and mouse click 
on Triggered Logging to start the datalog as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Once Triggered Logging is selected, the Triggered Logging criteria window will open as 
shown below.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• Once the Triggered Logging criteria window opens, there are numerous ways to configure the 
datalog trigger criteria. The above screen shot shows the Automatic Logging Trigger 
enabled, with Manual Start and Stop triggers. The screen shot below shows the Automatic 
Logging Trigger enabled, with Manual Start and Log For 300 seconds.  
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There are 5 pulldown menu options included in the Online File, Options, Data Logging, Tools & 
Help Tool Bar. Each pulldown menu serves a specific purpose. The fourth pulldown menu is 
Tools.  Left click on Tools and the following submenu will open. 
 

 

 
Tools: Under the Tools dropdown you can; check Protocol Stats, Update / Install Firmware, add a 
Custom.Channel Wizard,  add a Custom Channel Editor and use Action Management to configure 
Action Triggers. The Tools pulldown menu has additional features in the online mode that are 
not available in the offline mode. 
 

• The Tools dropdown submenu enables you to:  

o Protocol Stats – Displays GEN4 PRO XTREME ECU online communication statistics. 
o Update / Install Firmware – Utility to install or update the GEN4 PRO XTREME 

firmware. 
o Add Custom Channel Wizard – Enables Input channels to be configured. 
o Custom Channel Editor – Enables Output channel, Guage templates and Data Log 

Fields to be configured.  
o Action Management – Enables Action Triggers to be configured.  
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Protocol Stats window 

  
The protocol stats will update and show relevant data when the computer and GEN4 ECU are 
communicating back and forth.  
 
Update / Install Firmware window 

 
*This is scheduled for a future firmware release*  
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Add Custom Channel Wizard window 

  
  *More information coming soon* 
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Custom Channel Editor window 

 
 
*More information coming soon* 
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Action Management window 

 

 

 
 

 

 
 
 
 
 

 

 

 
 
 
 

*More information coming soon* 
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10. BIGCOMM PRO CONFIGURATION & CALIBRATION TOOL BAR  
Back to Table of Contents 

 
 

 

 

 

 

 

 

 

 

 

 

The BigComm Pro Configuration & Calibration Tool Bar incorporates the menus and 
submenus to allow you to configure and calibrate each portion of the overall Project, such as 
System, Fuel, Spark, Air Fuel Ratio, etc. The BigComm Pro Configuration & Calibration Tool Bar 
has been purposely laid out, such that for an initial Project configuration and calibration, you 
work from left to right to sequence thru each of the individual configuration and calibration 
menus and submenus i.e. Systems first, Fuel Settings second, Start Up / Idle third, etc. 
Subsequent to the initial Project configuration and calibration, the BigComm Pro Configuration 
& Calibration Tool Bar menus and submenus can be randomly selected to continue to refine 
the Project’s configurations and calibrations. 

Key BigComm Pro ground rules 
Before we get into the BigCommPro Configuration and Calibration Tool Bar, there are several key 
ground rules to remember:  
   
(1) When working inside any of the Configuration and Calibration Tool Bar menus and 
submenus, the configuration and calibration changes need to be “burned” into the ECU to save 
the changes when you are done making changes. The Burn button    is located in the 
lower right-hand corner of every table. Clicking on the Burn button ensures the changes you 
make will be permanently saved to the ECU. Every time you hit the Burn button the BigComm 
Pro software will burn the entire project into the ECU. This is so that if there were any areas you 
forget to hit the burn button the entire project will be sent to the ECU.     
 

Configuration 
& Calibration 

Tool Bar 
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(2) In the System Menu in order to complete the changes for certain ECU parameter 
configuration the ignition switch needs to go through an on-off key cycle to the ECU for the 
changes to take effect. The two System submenus requiring this are Generic Port Editor and 
Hardware Configuration. Failure to switch the ignition off for up to 30 seconds may prevent the 
changes from taking effect.   

(3) What’s displayed in the Configuration & Calibration Tool Bar submenus, depends on which 
options have been enabled.  

For example, when initially selecting the Fuel Settings menu  you may only see the 
following options listed in the submenu:  

  
 

 

 

 

 

 

Now let’s say you want to enable Intake Air Temperature Correction for your combination. In 
order to do so, you need to go to the Fuel Settings menu and highlight and select Fuel Modifier 
Selection using the left mouse key as shown below. 

 

 

 

 

 

 

Once Fuel Modifier Selection is selected, the Fuel Modifier Selection configuration window will 
open as shown below. Once opened, the Air Temp Correction needs to be enabled by selecting 
the Enabled button in the Air Temperature Correction dialogue window and then clicking on 
the Burn button.  



BS3 GEN4 PRO XTREME 

 Revision 1.1 61 
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The Air Temperature Correction will now be displayed as a submenu in the new Fuel Settings 
menu as shown below. 

 

 

 

 

 

 

 

The procedure detailed above is how to add any available modifier table submenu into the 
BigComm Pro Configuration and Calibration Tool Bar menus.   
 

How to edit changes in BigCommPro: 

BigComm Pro has several types of editor windows, represented by Curves, Tables & Parameters. 
The BigComm Pro software represents each of these editing windows with the following icons:  

 

Curve Window Icon: 

 

  
 

Table Window Icon:  

 

 

  
  
Parameter Window Icon: 
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The following are examples of each editor window:   

Curve Window: 

 

Table Window: 
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Parameter Window: 

 

 

 

 

As you can see, Curve, Table and Parameter windows have a different look and feel so, it’s 
important to understand how to navigate, configure, edit and save (Burn) the data changes for 
each of them. 
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11. HOW TO NAVIGATE & CONFIGURE CURVE WINDOWS 
Back to Table of Contents 

A Curve window can be easily identified by having a yellow curved line with blue dots associated 
with each editable data point. A Curve is typical referred to a 2D Curve made up of a vertical Y-
Axis on the left and a horizontal X-Axis on the bottom. A Cranking Curve as shown below will be 
used this example. All BigComm Pro Curve windows can be navigated, configured, edited and 
saved (Burn) in the same way. 

  
 

 

 

 

 

 

 

 

 

 

 

 

Let’s take a closer look at how to navigate & configure Curve windows changes by understanding 
the features of the Curve window GUI. The balance of the Curve window GUI features are 
detailed below. 

File:  By selecting the File pulldown menu, using the left mouse key, you can Save or Load 
individual Curves as shown below. This can be done offline or online when working in a Project.  

 
 
 
 
 
 
 
 
 
 
 
 

Curve window 2D Curve 
with X & Y-Axis 

Curve window Data 
Viewing and Editing Table 

 

Real-time “ellipse” operating point 
Y-Axis Output data point values  

X-Axis Input data 
point values  

Curve window “blue dot”  
editable data point values 

 Curve window name 

 Real-time “green dot 
with line” operating 
point moves along 

the curve 

Curve window Undo, Redo, 
Burn & Close Tool Bar 

 

“Red Dot” Input and Output data 
point values from the Data Viewing 

and Editing Table  
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View: By selecting the View pulldown menu you can enable and disable the Lower Help Pane 
which will be displayed below the lower data viewing & editing table as shown below. This can be 
done offline or online when working in a Project. 
 
Cranking Curve window with Lower Help Pane disabled 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Cranking Curve window with Lower Help Pane enabled 
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 By selecting the “3 dot” icon located in the upper left-hand corner of the Curve window you 
can manually reset the X-Axis & Y-Axis minimum and maximum values or the X-Axis 
Maximum and Y-Axis Maximum with Auto Scale. You can also; Set History Timeout, Show 
baseline graph, Revert to baseline, Selection Follow Mode and Set Coarse Step Count.  This 
can be done offline or online when working in a Project. Additional detail is below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Set Y Axis Minimum (0.0) - Select to reset Y-Axis Minimum to desired value 
Reset Y Axis Minimum to Default (0.0) - Select to reset Y-Axis Minimum to 0.0 
Set Y-Axis Maximum - Select to maximize the 2D Curve window fit for the Y-Axis 
Auto Scale Y Axis Maximum - BigCommPro will auto scale the Y-Axis values entered in the Y-
Axis based on the values entered  
Set X-Axis Minimum - Select to reset X-Axis Minimum to desired value  
Set X-Axis Maximum - Select to maximize the 2D Curve window fit for the X-Axis 
Auto Scale X Axis Maximum  BigCommPro will auto scale the values entered in the X-Axis 
based on the values entered  
Set History Timeout – INFO COMING SOON 
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Show baseline graph (CTRL+B) – Select to view the “baseline” curve to show the initial curve 
data point values. Once selected, a shaded yellow dashed line with gray data point values will 
appear in the 2D graph window to show the baseline data point values prior to the “new” data 
point value changes you made as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Revert to baseline – Select to revert the “New” curve to the “Baseline” curve.  Once selected, the 
“New” curve will be replaced with the “Baseline” curve as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
                                                  
 
                                                   THIS AREA LEFT BLANK INTENTIONALLY 
 
 
 
 

“Baseline” Cranking 
curve for the -14.8 
thru 64.4 CLT (F) 
data points. 

 

“New” Cranking curve based on 
new  Cranking PW values for the  

-14.8 thru 64.4 CLT (F) data 
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Selection Follow Mode (CTRL+F) – Select to display the “Red Dot” Input and Output data point 
values from the Curve window Data Viewing and Editing Table in the Curve window 2D 
Curve with X & Y-Axis. 

 
Curve window with Selection Follow Mode disabled 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Curve window with Selection Follow Mode enabled 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Set Coarse Step Count - INFO COMING SOON 
 

 By selecting the “Blue box with white Question Mark” icon, located in the upper left-
hand corner of the Curve window, a yellow dialogue box will open to show specific details 
about the particular Curve window being edited as shown below. Once opened, you can 
click on the Blue X to close the yellow dialogue box. 

“Red Dot” Input and Output data point values 
from the Data Viewing and Editing Table are 

displayed in the 2D Curve graph window 

“Red Dot” Input and Output data point values 
from the Data Viewing and Editing Table are 
displayed in the 2D Curve with X & Y-Axis window 
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 By selecting the “3 dot” icon, located in the upper right-hand corner of the Curve window, 
you can switch between the Curve window displaying both the Curve window 2D Curve 
with X & Y Axis and the Curve window Data Viewing and Editing Table or just displaying 
the Curve window 2D Curve with X & Y-Axis as shown below. 

Curve window displaying both the 2D Curve with X & Y Axis and the Data Viewing and  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Curve window Data 
Viewing and Editing Table 

 

Curve window 2D Curve 
with X & Y-Axis 
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Curve window displaying only the 2D Curve graph window with X & Y Axis  
 

 
 
 
 
 
 
 
 
 
 
 
 

12. HOW TO EDIT AND SAVE CURVE WINDOWS  
Back to Table of Contents 

We will now focus on how to Edit and Save (Burn) Curve windows data point values.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 

2D Curve graph window 
with X & Y-Axis 

Curve window 2D Curve 
with X & Y-Axis 

Curve window Data 
Viewing and Editing Table 

 

Real-time “ellipse” operating point 
Y-Axis Output data point values  

X-Axis Input data 
point values  

Curve window “blue dot”  
editable data point values 

   Curve window name 

 Real-time “green dot 
with line” operating 
point moves along 

the curve 

Curve window Undo, Redo, 
Burn & Close Tool Bar 

 

“Red Dot” Input and Output data 
point values from the Data Viewing 

and Editing Table  
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There are two ways to edit the Curve window data point values. The first is to directly edit the 
“blue dot” data point values along the yellow 2D curve. The second is to edit the data point 
values using the Curve window Data and Editing table. Each of these methodologies are 
explained below.  
 
Directly editing the “blue dot” data values along the yellow 2D curve using the mouse to 
“drag and drop” 

You can directly edit the “blue dot” data point values along the yellow 2D curve, by left mouse 
clicking on any of the “blue dot” data point values along the 2D curve. Once the left mouse key is 
clicked on the “blue dot”, it will turn red to indicate it is ready to be edited. Holding down on the 
left mouse key, “drag and drop” the red dot, up or down to a new desired value. Once you drag 
the red dot to the new desired value, release the left mouse key to retain the new value. Then 
left mouse click again, off the red dot, to turn it blue to reflect the new “blue dot” data point value 
along the 2D curve. See below. 
 
Note: You may want to enable Show baseline graph so you can see how your changes compare 
to the baseline curve.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: The Undo or Redo buttons, located in the lower right-hand corner of the screen, are used 
to undo or redo the last changes made to the Curve window data point values along the 2D 
curve. 

Once the blue dot is 
left-mouse clicked on 

it will turn red to 
indicate it is ready to 

be edited 
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Note: The Close button, located in the lower right-hand corner of the screen, is used to close out 
the Curve window screen. The Curve window edited changes are not saved when the Close 
button is selected. Edited changes are only permanently saved when the Burn button is 
selected! 

 
 
There are a couple of very important things to note at this point;  

The first is, as soon as you highlight any Curve window data point value along the 2D curve or in 
the Data Viewing and Editing Table, you will see the flame icon in the Burn button, 

Then left-mouse click 
again, off the red dot, 
to turn to it blue to 
reflect the new “blue 
dot” data point along 
the 2D curve.  

 

Undo 
Button 

Redo 
Button 

Burn button must 
be selected to 
permanently save 
edited changes.  

 

The Close button 
is used to close 
out of the Curve 
window screen. It 
does not save the 
edited changes.  

 

Then drag the red dot 
to the new desired 

value and release the 
left mouse key to 

retain the new value. 
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located in the lower right-hand corner of the screen, will illuminate red, as shown above, to 
indicate the BigComm Pro software is anticipating a change to take place. You must left-mouse 
click on the illuminated red flame Burn button after making any changes to Curve 
window data point values in order to permanently save the edited changes. If the 
illuminated red flamed Burn button is not left-mouse clicked on, the edited changes will 
not be saved! 

The second is, after left-mouse clicking on the Burn button, the illuminated red flame icon 
in the Burn button will illuminate back to white, to indicate the edited changes have been 
permanently saved as shown below.  

 

 
 
There are numerous other ways to edit the “blue dot” data point values along the yellow 2D 
curve other than using the mouse to “drag and drop”. They are explained below.  
 

Curve window Data 
Viewing and Editing Table 

 

Curve window 
Modifier Buttons 
located in the  
Data Viewing 
and Editing Table 

 

After left-mouse clicking the 
Burn button, the illuminated 
red flame icon in the Burn 
button will illuminate back to 
white, to indicate the edited 
changes have been 
permanently saved  
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Editing the Curve window data point values using the Modifier Buttons

 
 
The “blue dot” data points along the yellow 2D curve can also be edited using the Modifier 
Buttons located in the Curve window Data Viewing and Editing Table highlighted above. The 
data points can be edited individually, grouped or all together by depressing and holding down 
on the left-mouse key and highlighting one box or row of boxes you want to edit. Once 
highlighted, the editing table boxes will turn a gray/blue and the blue dots along the 2D curve will 
turn red, to indicate the data point values are ready to be edited using the Modifier Buttons. 
You can then select the Modifier Buttons to add, subtract, increase, etc the data point values. 
How to edit the 2D curve data point values using each of the Modifier Buttons is explained 
below. 
 
Note: Curve window Data Viewing and Editing Table data point values can be “copy” & “paste” 
into other Curve window Data Viewing and Editing Tables using CTRL-C to copy and CTRL-V to 
paste.   

 
Equal “Set To” Modifier Button 
 

Equal “Set To” is the first Modifier Button. It is used to set the highlighted data point value(s) in 
the table to the same value(s) / number(s). For example, if you want to set (5) data point values to 
same number, you use the Equal “Set To” Modifier Button. You do so by highlighting the (5) 
boxes in the table and then select the Equal “Set To” Modifier Button using the left-mouse 
Button. Once selected, a dialogue window will open to ask you to Set Selected Cells to: At this 
point, type in the number you want for all (5) data point values and select OK. Once OK is 
selected, the (5) new “equal” data point data point values will appear in the Curve window Data 
Viewing and Editing Table and along the yellow 2D curve.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 
Note: If at any point you close out of the Curve window, the Back-Arrow Undo or Forward-
Arrow Redo buttons will go grey indicating you cannot go back or forward. This is because 
the BigComm Pro software only keeps track of the edited changes while the Curve 
window screen is open.  

 
Up Arrow “Increment” Modifier Button 
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Up Arrow “Increment” is the second Modifier Button. It is used to increase the highlighted data 
point value(s) by 0.1 increments, which is the default incremental step change. For example, if 
you want to increase (5) data point values by the same increment, you use the Up Arrow 
“Increment” Modifier Button. You do so by highlighting the (5) boxes in the table and then 
select the Up Arrow “Increment” Modifier Button using the left-mouse key. Once selected, 
continue to left-mouse click on the Up Arrow “Increment” Modifier Button. Every time the left-
mouse is clicked, the values will increase by 0.1. As you are left-mouse clicking, the (5) “0.1 
incremented” data point data point values will appear in the Curve window Data Viewing and 
Editing Table and along the yellow 2D curve. Continue to click the left-mouse button until 
reaching the new desired values.  
 
Note: 0.1 increment is the default increment step change. You can change the incremental step 
change amount, by first highlighting a single or multiple data point value(s) in the Curve window 
Data Viewing and Editing Table by depressing the left-mouse key. Once highlighted, click the 
right-mouse key to open a dialogue window and select Set increment amount using the right or 
left-mouse key. Once selected, another dialogue window will open asking for the Preferred Cell 
Increment Size. At this point, type in the desired increment step change and left-mouse click on 
OK. This will be the new default increment step change. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button 
or Forward-Arrow Redo button, located in the lower right-hand corner of the screen, 
to undo or redo the last changes made to the Curve window data point values. Also, don’t forget 

Burn button,   using the left-mouse key, when you are done editing to select the 
the Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button is only 
used to “close” out of the Curve window screen. Edited changes are only permanently 
saved when the Burn button is selected! 

 
Down Arrow “Decrement” Modifier Button 

 
Down Arrow “Decrement” is the third Modifier Button. It is used to decrease the highlighted 
data point value(s) by 0.1 increments. For example, if you want to decrease (5) data point values 
by the same decrement, you to use the Down Arrow “Decrement” Modifier Button. You do so 
by highlighting the (5) boxes in the table and then select the Down Arrow “Decrement” 
Modifier Button using the left-mouse key. Once selected, continue to left-mouse click on the 
Down Arrow “Decrement” Modifier Button. Every time the left-mouse is clicked, the values will 
decrease by 0.1. As you are left-mouse clicking, the (5) “0.1 decremented” data point data point 
values will appear in the Curve window Data Viewing and Editing Table and along the yellow 
2D curve. Continue to click the left-mouse button until reaching the new desired values.  
 
Note: 0.1 decrement is the default decrement step change. You can change the decremental 
step change amount, by first highlighting a single or multiple data point value(s) in the Curve 
window Data Viewing and Editing Table by depressing the left-mouse key. Once highlighted, 
click the right-mouse key to open a dialogue window and select Set increment amount using 
the right or left-mouse key. Once selected, another dialogue window will open asking for the 
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Preferred Cell Increment Size. At this point, type in the desired decrement step change and 
left-mouse click on OK. This will be the new default decrement step change. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to 

button, using the left-mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

Minus “Decrease By” Modifier Button 
 

Minus “Decrease By” is the fourth Modifier Button. It is used to decrease the highlighted data 
point value(s) in the table by the same amount. For example, if you want to decrease (5) data 
point values by the same amount, you use the Minus “Decrease By” Modifier Button. You do 
so by highlighting the (5) boxes in the table and then select the Minus “Decrease By” Modifier 
Button using the left mouse key. Once selected, a dialogue window will open to ask you to 
Decrease Selected Cells by: At this point, type in the number you want all (5) data point values 
to be decreased by and select OK. Once OK is selected, the (5) new “decreased” data point data 
point values will appear in the Curve window Data Viewing and Editing Table and along the 
yellow 2D curve.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to 

button, using the left-mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
Plus “Increase By” Modifier Button 

 
Plus “Increase By” is the fifth Modifier Button. It is used to increase the highlighted data point 
value(s) in the table by the same amount. For example, if you want to increase (5) data point 
values by the same amount, you use the Plus “Increase By” Modifier Button. You would do so 
by highlighting the (5) boxes in the table and then select the Plus “Increase By” Modifier 
Button using the left-mouse key. Once selected, a dialogue window will open to ask you to 
Increase Selected Cells by: At this point, type in the number you want all (5) data point values to 
be increased by and select OK. Once OK is selected, the (5) new “increased” data point data point 
values will appear in the Curve window Data Viewing and Editing Table and along the yellow 
2D curve.  
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Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to 

button, using the left-mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
 Multiply “Scale By” Modifier Button 

 
Multiply “Scale By” is the sixth Modifier Button. It is used to increase or decrease the highlighted 
data point value(s) in the table by the same percentage. For example, if you want to increase or 
decrease the (5) data point values by the same percentage, you use the Multiply “Scale By” 
Modifier Button. You do so by highlighting the (5) boxes in the table and then select the 
Multiply “Scale By” Modifier Button using the left-mouse key. Once selected, a dialogue 
window will open to ask you to Multiply Selected Cells by: ex. 1.2 = raise by 20%. At this point, 
type in the number (i.e. percentage) you want all (5) data point values to be increased or 
decreased by as a percentage and select OK. For example, if you want to increase all (5) data 
point values by 10%, you would enter 1.1. If you want to decrease all (5) data point values by 
10%, you would enter .9. Once OK is selected, the (5) new “percent increased, or percent 
decreased” data point data point values will appear in the Curve window Data Viewing and 
Editing Table and along the yellow 2D curve.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to 

button, using the left-mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
Interpolate Modifier Button  

 
Interpolate is the seventh Modifier Button. It is used to interpolate the data point value(s) in the 
table relative to the furthest to the left and right highlighted data point values. The Interpolate 
Modifier Button is an effective way to quickly change the profile of Curve window’s 2D curve. 
For example, if you want to interpolate between the (5) highlighted data point values, you use 
the Interpolate Modifier Button. You do so by first highlighting the (5) boxes in the table and 
then select the Interpolate Modifier Button using the left mouse key. Once the Interpolate 
button is selected, the data point values in the (3) highlighted boxes, will be interpolated evenly 
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between the first and fifth boxes data point values and the (3) new “interpolated” data point data 
point values will appear in the Curve window Data Viewing and Editing Table and along the 
yellow 2D curve.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to 

button, using the left-mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 
13. HOW TO NAVIGATE & CONFIGURE TABLE WINDOWS 
Back to Table of Contents 

A Table window can be easily be identified by 8 x 16, 16 x 16, and 24 x 24 cells of numbers or 
“Maps” with the vertical Y-Axis on the left and a horizontal X-Axis on the bottom. In most cases, 
the primary Tables, i.e. Fuel, Spark Advance and Target LAMBDA, vertical Y-Axis are 
represented by the Engine Load (Engine Manifold Pressure in KPa or Psig) or TPS (Throttle 
Position Sensor) Throttle position opening as a percentage and the horizontal X-Axis is 
represented by Engine Speed (RPM).  A Fuel Table, as shown below will be used for this 
example. All BigComm Pro Table windows can be navigated, configured, edited and saved (Burn) 
in the same way. 

 

 

 

 Table window name 

Table window “Map” 
with X & Y-Axis 

Table window Undo, Redo, 
Burn & Close Tool Bar 

 

Table window Modifier Buttons 
located in the  upper right-hand 
corner of the screen 

 

Table window 3D 
View selection box 

 

Table window X-Axis 
& Y-Axis  Rescale 

 

 

Real-time “ellipse” 
operating point 
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Let’s take a closer look at how to navigate & configure Table windows changes by understanding 
the features of the Table window GUI. The balance of the Table window GUI features are 
detailed below. 

File:  By selecting the File pulldown menu, using the left mouse key, you can Save or Load 
individual Tables as shown below. This can be done offline or online when working in a Project.  

 
 
View: By selecting the View pulldown menu you can enable and disable the Lower Help Pane 
which will be displayed below the Y-Axis of the Fuel Table Map as shown below. This can be done 
offline or online when working in a Project. 
Fuel Table1 window with Lower Help Pane disabled 
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Fuel Table1 Table with Lower Help Pane enabled 

 

 

 

 

 

 

 

 

 

 

 

 

By selecting the “Blue box with white Question Mark” icon, located in the upper left-
hand corner of the Table window, a yellow dialogue box will open to show specific details 

about the particular Table window being edited as shown below. Once opened, you can click on 
the Blue X to close the yellow dialogue box. 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

By selecting the Table window Toggle Re-bin X & Y button, located in the lower left-hand   
corner of the Table window, you can rescale the X & Y-Axis values (see below). It is 
recommended to save the current table in the event you make a mistake. Also, there are no back 
or forward arrows in this process, which is why it’s recommended to save the table ahead of 
time.  
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Table window showing the Toggle Re-bin X & Y button 

 

Once the Table window Toggle Re-bin X & Y button is selected, using the left-mouse key, the 
following Table window will open displaying secondary X & Y-Axis, with black background and 
white numbers. These are the axis values you can adjust manually or by interpolating to rescale 
the X & Y-Axis values.  

Once the Table window, displaying the secondary X & Y-Axis, is opened you can adjust the 
individual X and Y-Axis values manually by typing in new values or by interpolating between the X 
and Y-Axis values you want to change.  

The Table window Toggle Re-bin button 
is used to rescale the X & Y-Axis. 

    

 

 The Table window Secondary  X & Y-Axis. 
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To manually adjust the X & Y-Axis values, select the individual value(s), by left mouse clicking on 
the X & Y-Axis value(s). Once selected, the X & Y-Axis value(s), will turn to a light gray background 
as shown below.  

Once highlighted, type in the new desired value(s). For this example, the (600) X-Avis value was 
change to (700) as shown below. Repeat this step for the balance of the X & Y-Axis values you 
want to manually change.  

To revert the changed X and Y-Axis value(s) to the original value(s), left-mouse click on the 
value(s), you want to change back. Once selected, right-mouse click to open the Revert to 
starting value dialogue window as shown below. Then highlight the Revert to starting value 
dialogue window by sliding the mouse over the Revert to starting value text. You know it is 
properly highlighted, when the Revert to starting value background turns a light gray. 

Highlight and type  in new cell value 
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Once highlighted, left-mouse click the Revert to starting value dialogue window to change it 
back to the original value.  

 

 

After manually changing the X and Y-Axis value(s), highlight and select the Apply New X&Y 
values, Interpolate Z button, located in the bottom right-hand corner of the Table window 
screen as shown below.  Use the left mouse key to select the Apply New X&Y values, 
Interpolate Z button. Then left-mouse click on the Close button to close out of the Table 
window.  
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Once the Close button is selected, the Table window, with the new X & Y-Axis values will open as 
shown below.  To permanently save the new X & Y-Axis values, left mouse click on the red flame 
illuminated Burn button. After a momentary pause, the red illuminated Burn button will turn 
white to indicate the new X & Y-Axis values have been permanently saved. Then select the Close 
button to close out of the Table window. 
 

 

 

 

 

 

Highlight and select the Apply New X&Y values, 
Interpolate Z button. Then select Close. 

 
 

Burn button with red illuminated flame must be selected to permanently save X-Axis 
cell value changes 
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We will now explain how to use the interpolate functionality to rescale the Table window X & Y-
Axis values.  

Once the Table window, displaying the secondary X & Y-Axis, is opened you can adjust the 
individual X and Y-Axis values by interpolating between the X and Y-Axis values you want to 
change.  

  

 
 

 The Table window Secondary  X & Y-Axis. 

   

 

After the Burn button’s illuminated flame turns white, 
select the Close button to close out of the Table window.  
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To use the interpolate functionality to adjust the X & Y-Axis values, select the individual value(s), 
by left mouse clicking on the X & Y-Axis value(s). With the mouse left mouse key held down, 
select the X & Y-Axis value(s) to be interpolated. The selected X & Y-Axis will turn to a light gray 
background as shown below.  

Once the X-Axis value(s) have been highlighted, right-mouse click on the highlighted X-Axis values 
to open the Interpolated selected cell values dialogue window, Once opened, highlight the 
Interpolated selected cell values text and left mouse click. Once the left-mouse is clicked, the 
highlighted X-Axis values between the farthest to the left and farthest to the right X-Axis values 
will be interpolated as shown below.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

Highlight and select Interpolate selected cell values 

 

New X-Axis interpolated values. 
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Once the new X-Axis cell values have been interpolated, highlight and left-mouse click on the 
Apply New X&Y values, Interpolate Z button located in the bottom right-hand corner of the 
Table window screen as shown below.  Use the left mouse key to select the Apply New X&Y 
values, Interpolate Z button. Then left-mouse click on the Close button to close out of the Table 
window.  

 
 
 
Once the Close button is selected, the Table window, with the new X & Y-Axis values will open as 
shown below.  To permanently save the new X & Y-Axis values, left mouse click on the red flame 
illuminated burn button. After a momentary pause, the red illuminated Burn button will turn 
white to indicate the new X & Y-Axis values have been permanently saved. Then select the Close 
button to close out of the Table window. 

 

 Highlight and select the Apply 
New X&Y values, Interpolate Z 
button. Then select Close. 

 

 

Burn button with red illuminated flame must be selected to permanently save X-Axis 
or Y-Axis cell value changes. 
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Table window Maps can be viewed as a 3D plot to quickly ensure there are no bad data points 
and to better visualize the Table window Map changes you are making. You can open the Table 
window 3D Map for the Table you are working on by left-mouse clicking the 3D View box in the 
upper right-hand corner of the Table window screen as shown below. 
 

 
 
 

 

 

After the Burn button’s illuminated flame turns white, 
select the Close button to close out of the Table window.  

 

 

Left mouse click on the 3D View box 
to open the Table window 3D Map.  
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Once the 3D View box is left-mouse clicked on the following Table window 3D Map will open.  
 

 

 

 

 

 

 

 

 

 

 

 

The following instructions will defer to the details found under the Table window 3D Map Help 
menu. The best way to better understand the Table window 3D MAP functionality is to select the 
3D Table Usage dropdown under the Help selection as shown below. Otherwise, the balance of 
the Table window 3D Map functionality is similar to the Table window 2D Map functionality and 
will not be covered in this section of the instructions. 

 

 

 Table window name 

Table window “3D Map” 
with X , Y & Z-Axis 

Table window Undo, Redo, Burn & Close Tool Bar 

 

Table window 3D 
View selection box 

 

Table window 3D 
Map modifier options  

Table window 
3D MAP real-
time operating 
point values 

 

Table window 3D 
Map Z-Axis 

amplitude scroll bar 
adjuster 

 
Highlighted 
Table window 
values 

 

 
Table window 3D Map 
scroll bar adjusters to 

rotate the 3D MAP view 

Table window 3D 
Map Help selection 



BS3 GEN4 PRO XTREME 

 Revision 1.1 91 

 

 

 
 
 
 
 
 
 
  

Select the 3D Table Usage 
submenu to gain access to 
Table window 3D Map 
usage instructions 

 

Left mouse-click on the 
3D Table Usage scroll bar 
to scroll thru the Table 
window 3D Map usage 
instructions. 
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Don’t forget as you make changes to the Table window 3D Map, you can use the Back-Arrow 
Undo button or Forward-Arrow Redo button, located in the lower right-hand 
corner of the screen, to undo or redo the last changes made to the Curve window data point 
values. Also, don’t forget to  select the Burn button, using the left mouse key, when you 
are done editing the Curve window data point values to permanently save the changes. The 
Curve window edited changes are not saved when the Close button is selected. 
The Close button is only used to “close” out of the Curve window screen. Edited changes 
are only permanently saved when the Burn button is selected! 
 
14. HOW TO EDIT AND SAVE TABLE WINDOWS 
Back to Table of Contents 

We will now focus on how to Edit and Save (Burn) Table windows “cell” values by primarily using 
the Table window Modifier Buttons. 
 
 

 

 

Before getting started on how to edit and save the Table windows, below are a couple key notes 
worth mentioning. 
 
Note: The Undo or Redo buttons, located in the lower right-hand corner of the screen, can be 
used to undo or redo the last changes made to the Table window cell values. 
 
Note: The Close button, located in the lower right-hand corner of the screen, is used to close out 
the Curve window screen. The Curve window edited changes are not saved when the Close 
button is selected. Edited changes are only permanently saved when the Burn button is 
selected! 

File and View 
Options 

 Table window name Fuel Table1 window 
24 x 24  “2D Map” 
with X & Y-Axis 

Table window Undo, Redo, 
Burn & Close Tool Bar 

 

Table window Modifier Buttons 
located in the  upper right-hand 
corner of the screen 

 

Table window 3D 
View selection box 

 

Table window X-Axis 
& Y-Axis  Rescale 

 

 

Real-time “ellipse” 
operating point 

Table window “2D 
Map” individual “cell” 
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There are a couple of very important things to note at this point;  

The first is, as soon as you select and change any of the Table window cell value(s) in the Table 
2D Map, you will see the flame icon in the Burn button, located in the lower right-hand 
corner of the screen, will illuminate red, as shown below, to indicate the BigComm Pro software 
is anticipating a change to take place. You must left-mouse click on the illuminated red flame 
Burn button after making any changes to Table window cell values in order to 
permanently save the edited changes. If the illuminated red flamed Burn button is not 
left-mouse clicked on, the edited changes will not be saved! 

The second is, after left-mouse clicking on the Burn button, the illuminated red flame icon 
in the Burn button will illuminate back to white, to indicate the edited changes have been 
permanently saved as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
                                       
                                               THIS AREA LEFT BLANK INTENTIONALLY 

Burn button with red illuminated flame must be selected to permanently save Table 
window 2D Map cell value changes. 
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There are many ways to edit the Table window “cell” values using the Modifier Buttons. A 
description on how to use each of the Modifier Buttons is detailed below.  
 
Editing the Table window “cell” values using the Modifier Buttons 

 
 
 

The Table window 2D Map cell values can be edited using the Modifier Buttons located in the 
upper right-hand corner of the Table window and highlighted above. The cell values can be 
edited individually, grouped or all together by depressing and holding down on the left-mouse 
key and highlighting one cell or rows and/or columns of cells you want to edit. Once highlighted, 
the cells will turn a gray/blue, to indicate the cell values are ready to be edited using the 
Modifier Buttons. You can then select the Modifier Buttons to add, subtract, increase, etc the 
cell values. How to edit the 2D Table window Map cell values using each of the Modifier Buttons 
is explained below. 
 
Note: Table window 2D Table Map cell values can be “copy” & “paste” into other Table window 
2D Table Maps using CTRL-C to copy and CTRL-V to paste.   
 

 
Green/white up arrow “Export Table” Modifier Button 
 

Green/white up arrow “Export Table” is the first Modifier Button. It is not used to edit the 
Table window 2D Map cell values. It is used to save the current 2D Table. You do so by selecting 
the Green/white up arrow “Export Table” Modifier Button using the left-mouse key. Once 
selected, a dialogue window will open with a default File Name. At this point, you can save the 
2D Table using the default file name or type in a file name you want to use and select Save. Once 
Save is selected, the 2D Table will be saved.  

 

 

After the Burn button’s illuminated flame turns white, 
select the Close button to close out of the Table window.  
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Green/white down arrow “Import Table” Modifier Button 
 

Green/white down arrow “Import Table” is the second Modifier Button. It is not used to edit 
the Table window 2D Map cell values. It is used to import an existing 2D Table. You do so by 
selecting the Green/white up arrow “Import Table” Modifier Button using the left-mouse key. 
Once selected, a dialogue window will open with existing 2D Table files that can be imported. At 
this point, you can select an existing 2D Table and select Open. Once Open is selected, the 2D 
Table will be imported.  
 

 
Equal “Set To” Modifier Button 
 

Equal “Set To” is the third Modifier Button. It is used to set the highlighted 2D Table cell value(s) 
to the same value(s) / number(s). For example, if you want to set (9) cell values to same number, 
you use the Equal “Set To” Modifier Button. You do so by highlighting the (9) 2D Table cells and 
then select the Equal “Set To” Modifier Button using the left-mouse Button. Once selected, a 
dialogue window will open to ask you to Set Selected Cells to: At this point, type in the number 
you want for all (9) cell values and select OK. Once OK is selected, the (9) new “equal” cell values 
will appear in the 2D Table window. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 
Note: If at any point you close out of the Table window, the Back-Arrow Undo or Forward-
Arrow Redo buttons will go grey indicating you cannot go back or forward. This is because 
the BigComm Pro software only keeps track of the edited changes while the Table 
window screen is open.  
 

 
Up Arrow “Increment” Modifier Button 
 

Up Arrow “Increment” is the fourth Modifier Button. It is used to increase the highlighted 2D 
Table cell value(s) by 0.1 increments, which is the default incremental step change. For example, 
if you want to increase (9) cell values by the same increment, you use the Up Arrow 
“Increment” Modifier Button. You do so by highlighting the (9) cells in the 2D Table and then 
select the Up Arrow “Increment” Modifier Button using the left-mouse key. Once selected, 
continue to left-mouse click on the Up Arrow “Increment” Modifier Button. Every time the left-
mouse is clicked, the cell values will increase by 0.1. As you are left-mouse clicking, the (9) “0.1 
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incremented” cell values will appear in the 2D Table window. Continue to click the left-mouse 
button until reaching the new desired cell values.  
 
Note: 0.1 increment is the default increment step change. You can change the incremental step 
change amount, by first highlighting a single or multiple cell value(s) in the 2D Table window by 
depressing the left-mouse key. Once highlighted, click the right-mouse key to open a dialogue 
window and select Set increment amount using the right or left-mouse key. Once selected, 
another dialogue window will open asking for the Preferred Cell Increment Size. At this point, 
type in the desired increment step change and left-mouse click on OK. This will be the new 
default increment step change. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
Down Arrow “Decrement” Modifier Button 
 

Down Arrow “Decrement” is the fifth Modifier Button. It is used to decrease the highlighted 2D 
Table cell value(s) by 0.1 increments. For example, if you want to decrease (9) cell values by the 
same increment, you to use the Down Arrow “Decrement” Modifier Button. You do so by 
highlighting the (9) cells in the 2D table and then select the Down Arrow “Decrement” Modifier 
Button using the left-mouse key. Once selected, continue to left-mouse click on the Down 
Arrow “Decrement” Modifier Button. Every time the left-mouse is clicked, the cell values will 
decrease by 0.1. As you are left-mouse clicking, the (9) “0.1 decremented” cell values will appear 
in the 2D Table window. Continue to click the left-mouse button until reaching the new desired 
cell values.  
 
Note: 0.1 decrement is the default decrement step change. You can change the decremental 
step change amount, by first highlighting a single or multiple cell value(s) in the 2D Table window 
by depressing the left-mouse key. Once highlighted, click the right-mouse key to open a dialogue 
window and select Set increment amount using the right or left-mouse key. Once selected, 
another dialogue window will open asking for the Preferred Cell Increment Size. At this point, 
type in the desired increment step change and left-mouse click on OK. This will be the new 
default decrement step change. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

mouse key, when you are done select the Burn button, using the left 
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editing the Curve window data point values to permanently save the changes. The Curve 
window edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
Minus “Decrease By” Modifier Button 
 

Minus “Decrease By” is the sixth Modifier Button. It is used to decrease the highlighted 2D Table 
cell value(s) by the same amount. For example, if you want to decrease (9) cell values by the 
same amount, you use the Minus “Decrease By” Modifier Button. You do so by highlighting 
the (9) cells in the 2D Table and then select the Minus “Decrease By” Modifier Button using the 
left mouse key. Once selected, a dialogue window will open to ask you to Decrease Selected 
Cells by: At this point, type in the number you want all (9) cell values to be decreased by and 
select OK. Once OK is selected, the (9) new “decreased” cell values will appear in the 2D Table 
window.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
Plus “Increase By” Modifier Button 
 

Plus “Increase By” is the seventh Modifier Button. It is used to increase the highlighted 2D Table 
cell value(s) by the same amount. For example, if you want to increase (9) cell values by the same 
amount, you use the Plus “Increase By” Modifier Button. You would do so by highlighting the 
(9) cells in the 2D Table and then select the Plus “Increase By” Modifier Button using the left-
mouse key. Once selected, a dialogue window will open to ask you to Increase Selected Cells 
by: At this point, type in the number you want all (9) cell values to be increased by and select OK. 
Once OK is selected, the (9) new “increased” cell values will appear in the 2D Table window.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
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 Multiply “Scale By” Modifier Button 
 

Multiply “Scale By” is the eight Modifier Button. It is used to increase or decrease the highlighted 
2D Table cell value(s) by the same percentage. For example, if you want to increase or decrease 
the (9) cell values by the same percentage, you use the Multiply “Scale By” Modifier Button. 
You do so by highlighting the (9) cells in the 2D Table and then select the Multiply “Scale By” 
Modifier Button using the left-mouse key. Once selected, a dialogue window will open to ask 
you to Multiply Selected Cells by: ex. 1.2 = raise by 20%. At this point, type in the number (i.e. 
percentage) you want all (9) cell values to be increased or decreased by as a percentage and 
select OK. For example, if you want to increase all (9) cell values by 10%, you would enter 1.1. If 
you want to decrease all (9) cell values by 10%, you would enter .9. Once OK is selected, the (9) 
new “percent increased, or percent decreased” cell values will appear in the 2D Table window.  
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

 
Interpolate Modifier Button  

 
Interpolate is the ninth Modifier Button. It is used to interpolate the cell value(s) in the 2D Table 
relative to the furthest to the left, right, upper and lower highlighted cells. The Interpolate 
Modifier Button is an effective way to quickly change the profile of Table window’s 2D Table. 
For example, if you want to interpolate between (9) highlighted cell values, you use the 
Interpolate Modifier Button. You do so by first highlighting the (9) cells in the 2D table and 
then select the Interpolate Modifier Button using the left mouse key. Once the Interpolate 
Modifier Button is selected, the cell values in the (5 of the 9) highlighted cells, will be 
interpolated evenly between the furthest to the left, right, upper and lower highlighted cells and 
the (5) new “interpolated” cell values will appear in the 2D Table window. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
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 Interpolate Horizontal Modifier Button  

 
Interpolate Horizontal is the tenth Modifier Button. It is used to interpolate the cell value(s) in 
the 2D Table between to the furthest to the left and right horizontal highlighted cells. The 
Interpolate Horizontal Modifier Button is an effective way to quickly change the profile of 
Table window’s 2D Table. For example, if you want to interpolate between (12) highlighted 
horizontal cell values, you use the Interpolate Horizontal Modifier Button. You do so by first 
highlighting the (12, 3 rows x 4 column) cells in the 2D table and then select the Interpolate 
Horizontal Modifier Button using the left mouse key. Once the Interpolate Horizontal 
Modifier Button is selected, the cell values in (6 of the 12) highlighted cells, will be interpolated 
evenly between the furthest to the left and right horizontal highlighted cells and the (6) new 
horizontal “interpolated” cell values will appear in the 2D Table window. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

Interpolate Vertical Modifier Button  
 

Interpolate Vertical is the eleventh Modifier Button. It is used to interpolate the cell value(s) in 
the 2D Table between to the furthest to the upper and lower vertical highlighted cells. The 
Interpolate Vertical Modifier Button is an effective way to quickly change the profile of Table 
window’s 2D Table. For example, if you want to interpolate between (12) highlighted vertical cell 
values, you use the Interpolate Horizontal Modifier Button. You do so by first highlighting the 
(12, 3 rows x 4 column) cells in the 2D table and then select the Interpolate Vertical Modifier 
Button using the left mouse key. Once the Interpolate Vertical Modifier Button is selected, 
the cell values in (4 of the 12) highlighted cells, will be interpolated evenly between the furthest 
to the upper and lower vertical highlighted cells and the (4) new horizontal “interpolated” cell 
values will appear in the 2D Table window. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
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Smooth Cells Modifier Button  

 
Smooth Cells is the twelfth Modifier Button. It is used to interpolate the cell value(s) in the 2D 
Table between all highlighted cells. The Smooth Cells Modifier Button is an effective way to 
quickly change the profile of Table window’s 2D Table. For example, if you want to interpolate 
between all (12) highlighted cell values, you use the Smooth Cells Modifier Button. You do so 
by first highlighting the (12, 3 rows x 4 column) cells in the 2D table and then select the Smooth 
Cells Modifier Button using the left mouse key. Once the Smooth Cells Modifier Button is 
selected, the cell values in (12 of the 12) highlighted cells, will be interpolated evenly between 
one another and the (12) new “interpolated” cell values will appear in the 2D Table window. 
 
Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 
 
 
 
 
 
 
 
 
 
 
  
                                                 THIS AREA LEFT BLANK INTENTIONALLY 
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15. HOW TO NAVIGATE & CONFIGURE PARAMETER WINDOWS  
Back to Table of Contents 

A Parameter window can be easily identified as having a number of configuration parameters   
arranged in a tabular format that can be adjusted using up/down arrow dialogue windows or 
selected using radio buttons. A Hardware Configuration Parameter window as shown below 
will be used this example. All BigComm Pro Parameter windows can be navigated, configured, 
edited and saved (Burn) in the same way. 

 

 

 

 

 

   

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Let’s take a closer look at how to navigate & configure Parameter windows changes by 
understanding the features of the Parameter window GUI. The balance of the Parameter 
window GUI features are detailed below. 
 

File:  By selecting the File pulldown menu, using the left mouse key, you can Save or Load 
individual Parameter configurations as shown below. This can be done offline or online when 
working in a Project.  

 

 

Configuration 
Parameters to be 
adjusted or selected 

Up/Down arrow 
dialogue windows used 
to adjust configuration 

parameter values 
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configuration 

parameter 
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Parameter window name 

Parameter 
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Close Tool Bar 
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View: By selecting the View pulldown menu, using the left-mouse key, you can enable and 
disable the Lower Help Pane which will be displayed above the Undo, Redo, Burn & Close Tool 
Bar as shown below. This can be done offline or online when working in a Project. 
 
Hardware Configuration Parameter window with Lower Help Pane disabled 

 

 
 

 

 

 

 

 

 

 

 

 

 



BS3 GEN4 PRO XTREME 

 Revision 1.1 103 

Hardware Configuration Parameter window with Lower Help Pane enabled 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

By selecting the “Blue box with white 
Question Mark” icons, adjacent to each 

of the Parameter window configuration 
parameters, a yellow dialogue box will open to 
show specific details about the particular 
parameter as shown below. Once opened, you 
can click on the Blue X to close the yellow 
dialogue box. 

 

 

 

 

 

 

 

 
  



BS3 GEN4 PRO XTREME 

 Revision 1.1 104 

16. HOW TO EDIT AND SAVE PARAMETER WINDOWS  
Back to Table of Contents 

We will now focus on how to Edit and Save (Burn) Parameter windows by using the up/down 
arrow dialogue windows or radio buttons to adjust or select each of the parameter values or 
selection options. 

 
 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 
 
Before getting started on how to edit and save the Parameter windows, below are a couple key 
notes worth mentioning. 

Note: The Undo or Redo buttons, located in the lower right-hand corner of the screen, can be 
used to undo or redo the last changes made to the Parameter window parameter adjustments 
or selection options. 
 
Note: The Close button, located in the lower right-hand corner of the screen, is used to close out 
the Parameter window screen. The Curve window edited changes are not saved when the 
Close button is selected. Edited changes are only permanently saved when the Burn 
button is selected! 
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There are a couple of very important things to note at this point;  

The first is, as soon as you select and change any of the Parameter window parameter 
adjustments or selection options, you will see the flame icon in the Burn button, 
located in the lower right-hand corner of the screen, will illuminate red, as shown below, to 
indicate the BigComm Pro software is anticipating a change to take place. You must left-mouse 
click on the illuminated red flame Burn button after making any changes to Parameter 
window parameter adjustments or selection options  in order to permanently save the 
edited changes. If the illuminated red flamed Burn button is not left-mouse clicked on, the 
edited changes will not be saved! 

The second is, after left-mouse clicking on the Burn button, the illuminated red flame icon 
in the Burn button will illuminate back to white, to indicate the edited changes have been 
permanently saved as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Burn button with red illuminated flame must be 
selected to permanently save Parameter window 
parameter adjustments or selection options. 
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There are several ways to edit the Parameter window parameter values or selection options 
using the up/down arrow dialogue windows or radio buttons. A description on how to use 
each is detailed below. 
 
The up/down arrow dialogue windows are used to adjust the Parameter window 
configuration parameter values. You do so by highlighting the parameter value in the up/down 
arrow dialogue window, using the left-mouse key. Once highlighted, you can type in the value 
(i.e. number) or use the up and down arrows to obtain the value (i.e. number) as shown above. 
Repeat this to adjust the balance of the Parameter window configuration parameter values. 
 
The radio buttons are used to select the Parameter window configuration options. You do so 
by selecting the radio button, using the left-mouse key, for the desired configuration parameter 
option you want. Once selected, a blue circle will illuminate within the radio button, to indicate 
the configuration parameter option has been selected as shown above. Repeat this to select the 
balance of the Parameter window parameter selection options. 
 

 

 

After the Burn button’s illuminated flame 
turns white, select the Close button to 
close out of the Parameter window.  
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Don’t forget as you make your changes, you can use the Back-Arrow Undo button or 
Forward-Arrow Redo button, located in the lower right-hand corner of the screen, to 
undo or redo the last changes made to the Curve window data point values. Also, don’t forget to  

button, using the left mouse key, when you are done editing the select the Burn 
Curve window data point values to permanently save the changes. The Curve window 
edited changes are not saved when the Close button is selected. The Close button 
is only used to “close” out of the Curve window screen. Edited changes are only 
permanently saved when the Burn button is selected! 
 

Note: If at any point you close out of the Parameter window, the Back-Arrow Undo or Forward-
Arrow Redo buttons will go grey indicating you cannot go back or forward. This is because the 
BigComm Pro software only keeps track of the edited changes while the Parameter window 
screen is open.  
 

This completes the instructions on how to navigate, configure, edit and save Curve, Table and 
Parameter windows. The next section of the instruction will explain how to use the BigComm 
Pro Configuration & Calibration Tool Bar menus and submenus to configure and calibrate 
each portion of the overall Project, such as System, Fuel, Spark, Air Fuel Ratio, etc. The BigComm 
Pro Configuration & Calibration Tool Bar menus and submenus consist of Curve, Table and 
Parameter windows, so it’s important to know how to effectively navigate, configure, edit and 
save the Curve, Table and Parameter windows prior to configuring and calibrating each portion 
of the overall Project. 
 
 
 
 
 
 
 
 
 
                                                 THIS AREA LEFT BLANK INTENTIONALLY 
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17. HOW TO BEGIN TO USE THE BIGCOMM PRO CONFIGURATION & 
CALIBRATION TOOL BAR MENUS AND SUBMENUS TO CONFIGURE AND 
CALIBRATE PROJECT 
Back to Table of Contents 

 

 

 

 

 

 

 

 

 

 

 

 

 

The BigComm Pro Configuration & Calibration Tool Bar incorporates the menus and 
submenus, consisting of Curve, Table and Parameter windows, to allow you to configure and 
calibrate each portion of the overall Project, such as System, Fuel, Spark, Air Fuel Ratio, etc. 

The BigComm Pro Configuration & Calibration Tool Bar has been purposely laid out, such that 
for an initial Project configuration and calibration, you work from left to right to sequence 
through each of the individual configuration and calibration menus and submenus i.e. Systems 
first, Fuel Settings second, Start Up / Idle third, etc. 

Subsequent to the initial Project configuration and calibration, the BigComm Pro Configuration 
& Calibration Tool Bar menus and submenus can be randomly selected to continue to refine 
the Project’s configurations and calibrations. 

 

  

Configuration 
& Calibration 

Tool Bar 
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Key BigComm Pro Ground Rules 
Before getting into how to use the BigComm Pro Configuration and Calibration Tool Bar 
menus and submenus to configure and calibrate each portion of the overall Project, let’s review 
several key ground rules:  
   
(1) When working inside any of the Configuration and Calibration Tool Bar menus and 
submenus, the configuration and calibration changes need to be “burned” into the ECU to 
permanently save the changes when you are done making changes. The Burn button   
is located in the lower right-hand corner of every Curve, Table and Parameter window. Selecting 
the Burn button, using the left-mouse key, ensures the changes you make will be permanently 
saved to the ECU. Every time you hit the Burn button, the BigComm Pro software saves the 
entire project to the ECU. This ensures that if at any point you forget to hit the burn button, 
when configuring and calibrating each portion of the overall Project, the entire Project 
configuration will be saved to the ECU.     

(2) Under the System menu, in order to complete certain ECU parameter 
configurations changes, the ignition switch needs to go through an on - 60 second off - on key 
cycle when connected to the GEN 4 PRO XTREME ECU for the changes to take effect. The two 
System submenus requiring this are Generic Port Editor and Hardware Configuration. Failure 
to switch the ignition off for up to 30 seconds will prevent the changes to take effect.   

(3) What’s displayed in the Configuration & Calibration Tool Bar submenus, depends on which 
options have been enabled.  

 

For example, when initially selecting the Fuel 
Settings menu  you may only see the following options listed 
in the submenu:  
  
 

 

 

 

Now let’s say you want to enable Intake Air Temperature 
Correction for your combination. In order to do so, you need 
to go to the Fuel Settings menu and highlight and select Fuel 
Modifier Selection, using the left mouse key as shown below. 
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Once Fuel Modifier Selection is selected, the Fuel Modifier Selection configuration window will 
open as shown below. Once opened, the Air Temp Correction needs to be enabled by selecting 
the Enabled button in the Air Temperature Correction dialogue window and then clicking on 
the Burn button.  
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The Air Temperature Correction will now be displayed as a submenu in the new Fuel Settings 
menu as shown below. 

 

 

 

 

 

 

 

 

The procedure detailed above is how to add any available modifier table submenu into the 
BigComm Pro Configuration and Calibration Tool Bar menus.   

 
Now we are ready to get into how to use the BigComm Pro Configuration and Calibration Tool 
Bar menus and submenus to configure and calibrate each portion of the overall Project. 
 
It is important to remember, the BigComm Pro Configuration & Calibration Tool Bar has been 
purposely laid out, such that for an initial Project configuration and calibration, you work from 
left to right to sequence thru each of the individual BigComm Pro Configuration and 
Calibration Tool Bar menus and submenus i.e. Systems first, Fuel Settings second, Start Up / 
Idle third, etc.  
 
34. FREQUENTLY ASKED QUESTIONS 
 • What does working “On line” vs. “Off line” mean?  
-Working “Off-line” = The BigStuff3 ECU is not powered up (PC Only).  Working “On-line” = The 
BigStuff3 ECU is powered on, the communication is connected between the GEN4 ECU and a PC, 
and the two are communicating with each other  
 
 • Should I use the camshaft position input (cam sync) with my distributor based GEN4 
system?  
-Without the camshaft position input (cam input connector in the main wire harness) hooked up, 
the GEN4 system still provides sequential fuel injection and individual fuel control per cylinder, 
but injector phasing (where the fuel is injected) and individual spark control will not function.  
 
• How can the GEN4 system provide sequential fuel injection and individual fuel control 
per cylinder without the cam camshaft position input hooked up? 
-When the engine starts cranking over, the GEN4 ECU begins firing the injector drivers, assigned 
to each injector, in the firing order inputted into the software. What the GEN3 system cannot do 
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without the cam camshaft position input hooked up is to determine where to inject fuel (the 
position in crankshaft degrees, relative to TDC, for each cylinder). 
 
• At what injector duty cycle % are my injectors considered out of control, or static? 
-Loss of injector control does not occur at 100% duty cycle, but at approximately 85% duty cycle. 
At 85% duty cycle the injectors are most likely not opening and closing in a controlled fashion.  

-This condition is termed “static” (vs. dynamic) control. An example why this condition is 
undesirable is if the GEN4 ECU demands more fuel (demanding a larger pulse width) and the 
injector is already static. The only way to move more fuel through the injector would be to 
increase the fuel pressure. Increasing the fuel pressure at the 1/8th mile marker is not possible, 
so things go bad quickly. 

-Also, teetering on and off at the static point is also undesirable. Lastly, running the injectors 
drivers static for long periods of time can damage them. 
 
• How do I set up my ignition system with the GEN4 system? 
-For more information on ignition system setups, beyond what is available in this manual, go to 
the How To/Help section on the BigStuff3 website, and then Ignition System Setup Tutorial. The 
link is: http://bigstuff3.com/pdf/Ignition%20Guide%20rev%201.2.pdf. There are nine (9) ignition 
system setups outlined. There is also information on the setting up the Ford TFI, GM HEI, GM 
Opti-spark & MSD8 ignition systems in the How To/Help section of the website. 
 
• Where can I find wiring harness information on the BS3 power-train system and optional 
systems?  
-Information on most of our wiring harnesses is available on our website at www.bigstuff3.com. -
-Go to the How To/Help section on the website. The first fourteen (14) files listed in this section 
are wiring diagrams. The link is: http://bigstuff3.com/gen4/  
 
• My engine will not start. What should I check?  
-Make sure the harness side header connectors, interfacing with the GEN4 ECU, are attached and 
tightened to no more than 15 – 20 inch lbs.  
-Make sure the battery voltage is at, or above, 12V during cranking. Low battery voltage 
conditions must be fixed before trying to start the engine. Battery voltage (especially during 
cranking) is even more important with coil-on-plug applications.  

Make sure you can see an RPM signal in the Dash. While turning the engine over, you should see 
at least 100 – 150 RPM. If no RPM signal is present, check that the crank input (crank trigger or 
distributor) signal wire is connected to the red wire in the BS3 “Crank” connector. Swap the 2 
wires and try again.  
 

-For distributor ignition based applications, make sure the BS3 points wire is connected to the 
ignition system points input terminal/wire. Applying 12V directly to the BS3 points wire will 
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immediately damage the GEN4 ECU!!  
-For COP engines (LSx and other standalone COP engine) the cam input cannot occur at the 
same time as the crank input!!! If this is the case, the engine will not start. The cam synch pulse 
must occur before a crank pulse. Ideally, 10* before the crank pulse.  
-For more information on ignition system setups, go to the How To/Help section on the BS3 
website, then to Ignition System Setup Tutorial.  
-With all coil-on-plug engines, make sure the coil ground eyelet is securely fastened to the 
cylinder head or engine block. No other grounds locations should be used.  
-The ECU may be in Clear flood Mode. Make sure the TPS sensor reads near 1-2% when the 
throttle is closed and near 100% when fully opened. If it reads near 100% when closed, the ECU 
is in clear flood mode and is not injecting fuel. Swap TPS pins A & C in the TPS connector.  
Make sure the crank sensor is connected.  
-The LS1 Cam sensor connections are: • A – Signal • B – Ground • C – 12V •  
The LS2 cam sensor connections must be (terminals A & C are swapped): • A – 12V • B – Ground 
• C – Signal  
• My engine timing does seem right, what should I check. 
-Make sure the firing order is correct.   
-Both the BS3 GEN4 main wiring harness and the MSD ignition system must be connected 
directly to the battery!! If not, ground loop issues are likely to occur. 
-Make sure your pulses per rev in the Operating Configuration table is correct for your 
application. For example, a four (4) magnet MSD crank trigger setup should have a value of 4. 
 
• I can’t get my LSx engine started.  
-I’m using an LS2 sensor in the front of the engine. 
-Swap pins A & C in the cam input connector around. My TPS sensor reads 100% when the 
throttle is closed and 0% when the throttle is fully opened.  Swap the wires A & C in the TPS 
connector. The engine may not start since the ECU senses that the Clear flood Mode has been 
invoked 
 
• If I am tuning in Alpha/N mode (Hardware Configuration, then Control Algorithm) can I 
use my 1 Bar MAP sensor for barometric compensation?  
-Yes, the automatic barometric compensation is hard-coded in the ECU. Leave the MAP sensor 
vacuum port exposed to the atmosphere. Do not plug the MAP vacuum port to the intake 
manifold.  
 
• What do I need to do to make sure my 3 step works correctly? 
-A clean 12VDC must be applied to Header 2 W1 meaning a relay with only 12vdc. Do not use the 
same 12VDC feeding the transbrake solenoid as flyback voltage from the transbrake releasing 
can damage the ECU!  
-Confirm the 3 Step settings in the System Menu / RevLimiters are configured correctly. The 
TPS% On threshold must be higher than the Off threshold.  
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• I do not think my injectors are pulsing. What can I check?  
Make sure the BS3 and MSD systems are grounded directly to the battery.  
Plug a “noid” light into each injector position in the injector wire harness. Turn the engine over 
and see if the light pulses for each injector location. 
 
• I do not think my COP coils are firing. What can I check?  
Make sure the BS3 main wire harness ground is wired directly to the battery. 
Make sure the coil ground wire is grounded to the engine block or cylinder head. No other 
ground location will work!  

• Can I use a 5 Bar MAP sensor? Yes, choose 5 Bar MAP sensor in the System Menu / Pressure 
and Sensor Configuration section. Be sure to cycle the 12VDC ignition on the ECU and you will 
need to recalibrate the fuel/afr/spark tables on this or any MAP sensor change.  
- Note: The 4 BAR MAP sensor sold by BigStuff3 is good to 52 PSI.  
 
• How do I know if my Bosch WBO2 sensor is bad? 
First make sure the sensor to main wire harness connection is good. 
Add the UEGOR signal to the Dash. Turn the ignition on. The UEGOR value should count down 
from 255 to a value close to 80. If it does not the heater is bad. The sensor should also read 15.9 
in the open air.  Also, if the O2 sensor is stuck at 14.7 for gasoline, the sensor is not connected or 
it’s defective.  
 
• How can I check if my NTK WBO2 Methanol sensor is working? 
First check the control circuitry by disconnecting the sensor from the harness. Turn the ignition 
to the BS3 ECU on. The AFR value in the Dash should read 6.4. Key off and reattach the sensor to 
the harness. Turn the ignition to the BS3 ECU back on. The sensor should read 6.9. Also, check 
your last Replay. The ECM Valid should read “On” to indicate the sensor is working. Always wire 
you the NTK WBO2 on a separate supply switch and always turn the sensor on after the engine is 
started.  
 
• What caused my O2 sensor to fail? 
Being dropped 
Running leaded fuel  
Running rich at idle  
 
• Can BS3 activate a transmission air shifter?  
• Does the GEN4 ECU offer an auto-shift feature? 
Yes, BigStuff3 offers an optional transmission auto-shift feature. The system will shift up to five 
(5) speeds with independent shift RPM and Hysteresis points. Once the system is configured for 
the auto-shift feature, a wire from ECU Header 2 location, P2 must be run to the ground side of 
the relay.   
 
• What dwell times should be used with the LS1 coils sold with my system? 
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With a 12V charging system from idle to approximately 4,000 RPM use about 3.0 milliseconds 
near idle and no more than about 4.0 milliseconds at approximately 4,000 RPM. From 
approximately 4,100 - Max RPM use no more than about 6 milliseconds of total dwell time at 
max RPM. With a 16V charging system from idle to approximately 4,000 RPM use about 2.0 
milliseconds near idle and no more than about 3.0 milliseconds at approximately 4,000 RPM. 
From approximately 4,100 - Max RPM use no more than about 4.5 milliseconds of total dwell 
time at max RPM. 
35. DATALOGGER ACRONYMS  
Back to Table of Contents 

 
Point Definitions are displayed in alphabetical order and are the same for either laptop based 
datalogging or pulling the data from the on board SD card.  
 

A 

AC_BUMP_ON – Air Conditioning Engine RPM increase active condition 
ACCEL_X – Accelerometer X Axis 
ACCEL_Y – Accelerometer Y Axis 
ACCEL_Z – Accelerometer Z Axis 
ACCEL_ENG – Acceleration Engine value 
ACT_IAC_POS – Current Idle Air Control Motor Position 
AFR_TARGET – Air Fuel Ratio Target 
AFR_L_BANK – Air Fuel Ratio Left Bank 
AFR_R_BANK – Air Fuel Ratio Right Bank 
AFR_CYL_1 – Air Fuel Ratio Cylinder 1 
AFR_CYL_2 – Air Fuel Ratio Cylinder 2 
AFR_CYL_3 – Air Fuel Ratio Cylinder 3 
AFR_CYL_4 – Air Fuel Ratio Cylinder 4 
AFR_CYL_5 – Air Fuel Ratio Cylinder 5 
AFR_CYL_6 – Air Fuel Ratio Cylinder 6 
AFR_CYL_7 – Air Fuel Ratio Cylinder 7 
AFR_CYL_8 – Air Fuel Ratio Cylinder 8 

B 

BARO – Outside Barometric Pressure   
BATTERY_VOLTAGE – Battery voltage  
BC_SENSOR_ERROR – Boost Controller Sensor Input Error 
BOOST_PSI – Intake Manifold Pressure 
BOOST_CL_DC – GN Boost Controller Duty Cycle Output % 
Boost_Inc PIDTerm – GN Boost Controller PID Increase % 
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C 

CLT – Coolant Temperature 
CORR_AIR – Fuel Percentage Air Temperature Correction 
CORR_AFTST – Afterstart Fuel Percentage Correction 
CORR_BARO – Barometric Fuel Percentage Correction 
CORR_CLT – Coolant Warm Up Temperature Fuel Percentage Correction 
CORR_E85 – E85 Fuel Percentage Correction 
CORR_ES_PVFC – Extended Source Power Valve Fuel Correction Percentage 
CORR_FP_COMP – Fuel Pressure Correction 
CORR_PVF – Power Valve Fuel Correction 
CORR_SLT – Start Line Fuel Percentage Correction  

D 

DAE_INPUT – DAE 12vdc Input true or false 
DSRD_BOOST_MAP – Desired Boost Map 
DSRD_SR2_MAP – Desired SR2 Map 
DUTY_CYCLE_BOOST_INC – Boost Controller Duty Cycle Output Increase % 
DUTY_CYCLE_BOOST_DEC – Boost Controller Duty Cycle Output Decrease % 
DUTY_CYCLE_PWM07 – Duty Cycle Output Pulse Width Modulation 07 
DUTY_CYCLE_PWM08 – Duty Cycle Output Pulse Width Modulation 08 
DUTY_CYCLE_PWM09 – Duty Cycle Output Pulse Width Modulation 09 
DUTY_CYCLE_NOS_PRG – Progressive Nitrous Duty Cycle Control Output Percentage 
DUTY_CYCLE_CYL1 – Fuel Injector Duty Cycle Percentage Cylinder 1  
DUTY_CYCLE_CYL2 – Fuel Injector Duty Cycle Percentage Cylinder 2 
DUTY_CYCLE_CYL3 – Fuel Injector Duty Cycle Percentage Cylinder 3 
DUTY_CYCLE_CYL4 – Fuel Injector Duty Cycle Percentage Cylinder 4 
DUTY_CYCLE_CYL5 – Fuel Injector Duty Cycle Percentage Cylinder 5 
DUTY_CYCLE_CYL6 – Fuel Injector Duty Cycle Percentage Cylinder 6 
DUTY_CYCLE_CYL7 – Fuel Injector Duty Cycle Percentage Cylinder 7 
DUTY_CYCLE_CYL8 – Fuel Injector Duty Cycle Percentage Cylinder 8 
DUTY_CYCLE_FRCMTR – Duty Cycle Force Motor Output Percentage (Used with 4L60E/80E) 
DUTY_CYCLE_TCC – Duty Cycle Torque Converter Clutch Output (Used with 4L60E/80E) 
DWELL_TIME – Ignition Coil Dwell Time 

E 
E85_SPARK_OFFSET – E85 Spark Offset  
ECM_RB_EC – NTK O2 Sensor Right Bank Error Code 
ECU_SYNC – Current ECU Synchronization Status 
EGT_CYL1 – Exhaust Gas Temperature Cylinder 1  
EGT_CYL2 – Exhaust Gas Temperature Cylinder 2 
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EGT_CYL3 – Exhaust Gas Temperature Cylinder 3 
EGT_CYL4 – Exhaust Gas Temperature Cylinder 4 
EGT_CYL5 – Exhaust Gas Temperature Cylinder 5 
EGT_CYL6 – Exhaust Gas Temperature Cylinder 6 
EGT_CYL7 – Exhaust Gas Temperature Cylinder 7 
EGT_CYL8 – Exhaust Gas Temperature Cylinder 8 
ENG_STATE – Engine State (1-Engine Cranking, 4-Engine Running Steady, 5-Engine Accelerating, 
6-Engine Decelerating, 7-Deceleration Fuel Cutoff)  
EGT_SHUTDOWN_ACTIVE – Exhaust Gas Temperature Shutdown Active Condition 
ETM_TORQ_STG – Engine Torque Management Torque Stage Current Value 
ETM_DS_ENG_ERROR – ETM Driveshaft or Engine RPM Error 
ETM_DS_ENG_DSRD – ETM Driveshaft or Engine RPM Desired 

F 

FP_SENSOR_ERROR – Fuel Pressure Sensor Input Error 
FP_WARNING_ACTIVE – Fuel Pressure Warning Active Condition 
FSL_TBL_INDEX – Fuel Spark Lambda current map enabled 
FUEL_FLOW_CYL1 – Calculated Fuel flow in lbs/hr for Cylinder 1 
FUEL_FLOW_CYL2 – Calculated Fuel flow in lbs/hr for Cylinder 2 
FUEL_FLOW_CYL3 – Calculated Fuel flow in lbs/hr for Cylinder 3 
FUEL_FLOW_CYL4 – Calculated Fuel flow in lbs/hr for Cylinder 4 
FUEL_FLOW_CYL5 – Calculated Fuel flow in lbs/hr for Cylinder 5 
FUEL_FLOW_CYL6 – Calculated Fuel flow in lbs/hr for Cylinder 6 
FUEL_FLOW_CYL7 – Calculated Fuel flow in lbs/hr for Cylinder 7 
FUEL_FLOW_CYL8 – Calculated Fuel flow in lbs/hr for Cylinder 8 
FUEL_FLOW_TOTAL – Total Calculated Fuel Flow of cylinders 1-8 in lbs/hr 

G 

GEAR – Current Gear position calculated by engine rpm drop 
GEN_BOOST_ADD – Generic Boost Tables Additional Boost Pressure 
GEN_FUEL_LBSHR_ADD – Generic Fuel Lbs/hr adder 
GEN_FUEL_MULT – Generic Fuel Multiplier Percentage Adder 
GEN_LAMBDA_ADD – Generic Lambda Fuel Adder 
GEN_LAMBDA_MULT – Generic Lambda Fuel Multiplier 
GEN_SPK_ADV_ADD – Generic Spark Advance Adder 
GS_ACCEL – Gear Speed Acceleration 
GYRO_X – Gyrometer X Axis 
GYRO_Y – Gyrometer Y Axis 
GYRO_Z – Gyrometer Z Axis  
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H 

HEAD_TEMP_RB – Head Temperature Right Bank. When in Pro Mod Mode located in the System-
>Hardware Configuration section this sensor is enabled for use. Pro Mod Mode sets the water 
and air sensors to 100* in the software so that they have no bearing on the overall VE fuel 
calculation. This is the GM Water Temperature Sensor.  
HEAD_TEMP_LB – Head Temperature Left Bank. When in Pro Mod Mode located in the System-
>Hardware Configuration section this sensor is enabled for use. Pro Mod Mode sets the water 
and air sensors to 100* in the software so that they have no bearing on the overall VE fuel 
calculation. This is the GM Air Temperature Sensor. 

I 

IAT – Intake Air Temperature 
ICF_CORR_CYL1 – Individual Cylinder Fuel Percentage Correction Cylinder 1  
ICF_CORR_CYL2 – Individual Cylinder Fuel Percentage Correction Cylinder 2 
ICF_CORR_CYL3 – Individual Cylinder Fuel Percentage Correction Cylinder 3 
ICF_CORR_CYL4 – Individual Cylinder Fuel Percentage Correction Cylinder 4 
ICF_CORR_CYL5 – Individual Cylinder Fuel Percentage Correction Cylinder 5 
ICF_CORR_CYL6 – Individual Cylinder Fuel Percentage Correction Cylinder 6 
ICF_CORR_CYL7 – Individual Cylinder Fuel Percentage Correction Cylinder 7 
ICF_CORR_CYL8 – Individual Cylinder Fuel Percentage Correction Cylinder 8 
ICS_CORR_CYL1 – Individual Cylinder Spark Correction Cylinder 1 
ICS_CORR_CYL2 – Individual Cylinder Spark Correction Cylinder 2 
ICS_CORR_CYL3 – Individual Cylinder Spark Correction Cylinder 3 
ICS_CORR_CYL4 – Individual Cylinder Spark Correction Cylinder 4 
ICS_CORR_CYL5 – Individual Cylinder Spark Correction Cylinder 5 
ICS_CORR_CYL6 – Individual Cylinder Spark Correction Cylinder 6 
ICS_CORR_CYL7 – Individual Cylinder Spark Correction Cylinder 7 
ICS_CORR_CYL8 – Individual Cylinder Spark Correction Cylinder 8 
INJ_GPW_AVE – Fuel Injector Gross Pulse Width Average 
INJ_PHASE_ANGLE – Fuel Injector Injection Event Phase Angle 
IOT – Fuel Injector Opening Tim 

L 
LAMBDA_CYL1 – Lambda Value Cylinder 1 
LAMBDA_CYL2 – Lambda Value Cylinder 2 
LAMBDA_CYL3 – Lambda Value Cylinder 3 
LAMBDA_CYL4 – Lambda Value Cylinder 4 
LAMBDA_CYL5 – Lambda Value Cylinder 5 
LAMBDA_CYL6 – Lambda Value Cylinder 6 
LAMBDA_CYL7 – Lambda Value Cylinder 7 
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LAMBDA_CYL8 – Lambda Value Cylinder 8 
LAMBDA_L_BANK – Lambda Reading Left Bank 
LAMBDA_R_BANK – Lambda Reading Right Bank 
LAMBDA_TARGET – Lambda Reading Left Bank 
LAMBDA_RB_UA – Lambda Right Bank NTK O2 Error Code 
LASER_HEIGHT__AD5 – Laser Height Sensor Reading 

M 

MAP – Engine Intake Manifold Pressure 
MPH – Miles Per Hour 

N 

NERNST_CYL1 – Resistance value of the Cylinder 1 Bosch O2 sensor. Normal value is around 
300. NERNST_CYL2 – Resistance value of the Cylinder 2 Bosch O2 sensor. Normal value is 
around 300. 
NERNST_CYL3 – Resistance value of the Cylinder 3 Bosch O2 sensor. Normal value is around 
300. 
NERNST_CYL4 – Resistance value of the Cylinder 4 Bosch O2 sensor. Normal value is around 
300. 
NERNST_CYL5 – Resistance value of the Cylinder 5 Bosch O2 sensor. Normal value is around 
300. 
NERNST_CYL6 – Resistance value of the Cylinder 6 Bosch O2 sensor. Normal value is around 
300. 
NERNST_CYL7 – Resistance value of the Cylinder 7 Bosch O2 sensor. Normal value is around 
300. 
NERNST_CYL8 – Resistance value of the Cylinder 8 Bosch O2 sensor. Normal value is around 
300. 
NOS_STAGE – Current NOS Stage  
NOS_BOOST_ENABLE – Nitrous or Boost Enable Arm Switch 
NOS_TIMER – When activated is the Nitrous Run Time 
NOS_ICS_CORR_CYL1 – Nitrous Individual Cylinder Spark Correction Cylinder 1  
NOS_ICS_CORR_CYL2 – Nitrous Individual Cylinder Spark Correction Cylinder 2 
NOS_ICS_CORR_CYL3 – Nitrous Individual Cylinder Spark Correction Cylinder 3 
NOS_ICS_CORR_CYL4 – Nitrous Individual Cylinder Spark Correction Cylinder 4 
NOS_ICS_CORR_CYL5 – Nitrous Individual Cylinder Spark Correction Cylinder 5 
NOS_ICS_CORR_CYL6 – Nitrous Individual Cylinder Spark Correction Cylinder 6 
NOS_ICS_CORR_CYL7 – Nitrous Individual Cylinder Spark Correction Cylinder 7 
NOS_ICS_CORR_CYL8 – Nitrous Individual Cylinder Spark Correction Cylinder 8  
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O 

O2_CORR_CYL1 – Closed Loop O2 AFR Fuel Correction Cylinder 1 
O2_CORR_CYL2 – Closed Loop O2 AFR Fuel Correction Cylinder 2 
O2_CORR_CYL3 – Closed Loop O2 AFR Fuel Correction Cylinder 3 
O2_CORR_CYL4 – Closed Loop O2 AFR Fuel Correction Cylinder 4 
O2_CORR_CYL5 – Closed Loop O2 AFR Fuel Correction Cylinder 5 
O2_CORR_CYL6 – Closed Loop O2 AFR Fuel Correction Cylinder 6 
O2_CORR_CYL7 – Closed Loop O2 AFR Fuel Correction Cylinder 7 
O2_CORR_CYL8 – Closed Loop O2 AFR Fuel Correction Cylinder 8 
O2_CORR_L_BANK – Closed Loop O2 AFR Fuel Correction Left Bank  
O2_CORR_R_BANK – Closed Loop O2 AFR Fuel Correction Right Bank 

P 

PCT_ETHANOL – Percentage of Ethanol in fuel (Need sensor to read properly) 
PEDAL_BIT_MODE – Pedal Bit Mode Current Condition 
PCT_TCC_SLIP – Percentage of Torque Converter Clutch Slippage (Used with 4L60E/80E) 
PRESS_FUEL – Fuel Pressure Reading 
PRESS_OIL – Oil Pressure Reading 
PRESS_TURBO – Turbocharger Pressure Reading 
PRESS_WG – Wastegate Pressure Reading  
PRESS_NOS – Nitrous Pressure Reading  
PRESS_PV – Pan Vacuum Reading  
PRESS_TL – Transmission Line Pressure Reading 
PRESS_DSRD_WG – CO2 Desired Wastegate  
PRNDL – Park / Reverse / Neutral / Drive / Low (Used with 4L60E/80E) 

R 

RACE_FUEL_LBS_HR – NOS Mode Race Fuel Lbs/hr fuel adder 
REV_LIMITER – Current condition of any active rev limiters 
RPM_ENGINE – Engine RPM 
RPM_TSS1_LB – Turbocharger Shaft Speed RPM Left Bank 
RPM_TSS2_RB – Turbocharger Shaft Speed RPM Right Bank 
RPM_ABS_FW – RPM Front Wheel Speed Sensor 
RPM_ABS_RW – RPM Rear Wheel Speed Sensor 
RPM_TOSS – RPM Transmission Output Speed Sensor or Driveshaft Sensor 
RPM_TISS – RPM Transmission Input Speed Sensor  

S 

SLT_MODE – Start Line Timing Mode Current Condition 
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SHOCK_RF__AD7 – Right Front Shock Reading 
SHOCK_LF__AD8 – Left Front Shock Reading 
SHOCK_RR__AD9 – Right Rear Shock Reading 
SHOCK_LR__AD10 – Left Rear Shock Reading 
SPK_ADV_BCP – Base Spark Advance  
SPK_ADV_CYL1 – Spark Advance Cylinder 1  
SPK_ADV_CYL2 – Spark Advance Cylinder 2 
SPK_ADV_CYL3 – Spark Advance Cylinder 3 
SPK_ADV_CYL4 – Spark Advance Cylinder 4 
SPK_ADV_CYL5 – Spark Advance Cylinder 5 
SPK_ADV_CYL6 – Spark Advance Cylinder 6 
SPK_ADV_CYL7 – Spark Advance Cylinder 7 
SPK_ADV_CYL8 – Spark Advance Cylinder 8 
SR2_TIMER – Current Race time after the release of the three step 
SR2_GEAR1_SPK_OFFSET – SR2 Gear 1 Spark Offset  
SR2_DS_SPK_OFFSET – SR2 Driveshaft or Engine Spark Offset 
SR2_DS_ERROR – SR2 Driveshaft or Engine RPM Error 
SR2_DS_DSRD – SR2 Driveshaft or Engine RPM Desired 
SS_SPK_NOS_RTD – Street Strip Nitrous Spark Retard 
SS_NOS_FUEL_ADD – Street Strip Nitrous Fuel Adder 
SS_NOS_LAMBDA_OFFSET – Street Strip Nitrous Lambda Target Offset  

T 

TPS – Throttle Position Sensor Percentage  
TOT – Transmission Oil Temperature Reading 
THREE_STEP_INPUT – Three Step Input 12vdc true or false 
THREE_STEP_MODE – Three Step Active Condition 
TRANS_GEAR_RATIO – Current Transmission Gear Ratio (Used with 4L60E/80E) 
TSD_GEAR1_OFFSET – Touch Screen Dash Gear 1 Offset 
TSD_SR2_DS_OFFSET – Touchscreen Dash SR2 Driveshaft or Engine RPM Offset 
TSD_ETM_DS_OFFSET – Touchscreen Dash ETM Driveshaft or Engine RPM Offset 
TWO_STEP_INPUT – Two Step Input 12vdc true or false 
TWO_STEP_ACTIVE – Two Step Active Condition 
TWO_STEP_MODE – Two Step Active Condition 

V 

VE -Volumetric Efficiency number calculated from the base fuel map 
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W 

WHEEL SPIN – Calculated wheel speed based off differential from either the rear wheel speed 
sensor or driveshaft sensor compared to the front wheel speed sensor. 
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